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Chapter 

1 
 STARWATCH DUAL PRO I  
  Main Function 

STARWATCH DUAL PRO I™ Introduction 
 
This chapter explains STARWATCH DUAL PRO I™ main functions and 
installation environment. 

STARWATCH DUAL PRO I™ Main Functions  

This program connects the controller and PC via Serial and TCP/IP communication to send and 
receive data.  It uses the data received to run its many functions. 

The controller and program are mutually connected to provide access control for higher security.  It 
also has a variety of applied additional functions to manage access control.  The user’s event data can 
be used as basis for time attendance reporting, as well as access control in corporate environments. 

• Usable Device 

Usable device : STAR 505R , STAR FINGER007 , STAR ICON100 , STAR SR505R , STAR 
FINGER007SR , STAR ICON100SR. 

STARWATCH DUAL PRO I™ can control 6 different types of controllers. For that reason, 
Cardholder can use two different types of cards, 125 KHz type card and 13.56 MHz type card. 

• Multi Port  Support 

This configuration can be applied from address 01 up to 99.  Using Serial or TCP/IP 
communication, you can connect up to 99 communication loops.  One port can connect up to 32 
devices.  However, if you go over the fixed number of devices in a communication loop, the PC 
resources may not support the setup.  Use the port to gain the best possible communication 
management depending on the environment. 

• Multi Language Support 

Multi Language support has two main languages as default (Korean, English).  Additionally, 5 
other languages are supported through user’s input.  Using a separate multi language definition 
program, the user can change the English characters into their own language as default to use the 
s/w in their own language. 

• Card Holder Management Function Combinations 
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Card Holder Management provide the customers the user’s basic information (name, company, 
dept, etc.) in addition, access group and time attendance data can be entered and modified in one 
screen. 

Also, registration and delete date can be scheduled for automatic deletion on selected date. 

Specific user can be deleted through card holder management, and can be recovered later on by 
managing separately.  The deleted user current status can be known. 

• Deleted User Managing Function 

The deleted user from card holder management is processed separately, and can be recovered to 
put into normal status, without any need to re-enter the user data.  Also, deleted user’s current 
status can be viewed as a report by making an inquiry. 

• Visitor Management Function 

Visitor management is processed by identifying the user as non regular card holder.  Visitor’s data 
contains company, name, and reason for visit, visitor, visiting dept.  Access area and time can be 
controlled by access group. 

Automatic delete function through specific date and time registered will erase card number.  Also, 
visitor’s current status can be seen as a report by making an inquiry. 

• Map Function 

Map can be setup using area and floor as basis to the corresponding floor.  Door and sensors are 
shown as icons, and depending on user options, the time of day when an event occurs will be 
shown automatically on the map. 

• TCP/IP and Serial Communication Simultaneous Support 

Using multi port function, network and serial communication can be activated simultaneously.  Set 
port 1 as serial and port 2 as network configuration to activate simultaneously using both ports. 

• Alarm Event Acknowledgement 

Using Alarm Event Acknowledgement, when an event occurs, the manager can input detail of 
information to acknowledge the alarm. 

All alarm events must be acknowledged by the manager to have the alarm event cancelled.  The 
acknowledged result is stored in database for later retrieval as a report. 

• Alarm Event Type Color Indication 

Using color to differentiate alarm event type gives easy monitoring in one screen.  The alarm 
event acknowledged by the manager is shown in black. 

• Various Access Control Reports 

The program contains reports of card holder, deleted user, access status, alarm status, visitor 
status; user permitted per authorized door, individual permitted door, and final access area giving 
variety of access control reports. 
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• Work Attendance and Various Related Reports 

Work attendance management function is included in basic form; therefore a separate program is 
not necessary. 

Individual work hour and holiday setup is possible.  You can configure expiration for date, month, 
and year to support report retrieval by making an inquiry for work hour data. 

Using the work hour data, you can calculate work hour, tardiness, leave of absence, overtime, 
holiday/weekend overtime, number of days worked, number of days of tardiness, and number of 
days of leave absence. 

User can modify the user data to reflect on expiration day, month, and year after the final worker 
ends the shift for the day. 

All work hour data can be sent to Excel file or text file to be used in other applications such as 
ERP. 

Reports support type by individual, day, month, month detail, yearly, and can be converted to look 
like HTML, PDF, and Excel format. 

• Various Export and Converting Function 

STARWATCH DUAL PRO I™ supports export and converting function through inquiry and report 
function. 

The file is sent as text or Excel format.  In this case, connecting the file to other applications (time 
attendance, wage, and ERP) can be efficient. 

In converting function, the report is converted to Excel, HTML, and PDF in its original form.  In this 
case, the file can be converted to be sent to the internet and email for data report transfer. 

• Various Options 

User can setup various options. 

You can setup event type indication, and saved database existence.  By setting up .wav file for 
each event type, you can have an alarm event sound. 

Also, when an event occurs, email dispatch function can be used if email server is present at 
location.  Email dispatch will be sent out to up to 3 people in matters to alarm event current status. 

Map indication existence can be setup by event type. 

• Uniformed User Interface 

User interface is uniformed by, using an icon for each function with one select operation for overall 
ease of use without difficulty.  Also, button key by menu type and function can be setup to operate 
function at once. 
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STARWATCH DUAL PRO I™ Installation Environment 

Operating System 

STARWATCH DUAL PRO I™ is a 32 bit Windows compatible S/W. It operates in Windows 2000 
Professional, Server Edition and higher versions, along with Windows XP Home and Professional 
Edition. 

The STARWATCH DUAL PRO I™ does not support Windows 95, ME, 98(SE) or NT 4.0. 

It is recommended the STARWATCH DUAL PRO I™ to be installed in Windows 2000 Professional or 
Windows XP Professional.  These operating systems are powerful and stable for STARWATCH 
DUAL PRO I™ operations. 

Minimum Configuration 

Minimum configuration is no more than 20 controllers and 40 readers for the system.  One or two port 
usage is suitable. Maximum users of less than 100-200 users are recommended in configuration.  
Memory expansion improves system functions therefore, having more memory is beneficial. 

 CPU: Pentium III-700 MHz or  Higher 

 Memory: 128 Mb or Higher 

 HDD: 2 Gig min. 

 Port: 2 serial port or Higher 

 Network: 1 Ethernet card 

 OS:  Windows 2000 Professional or Windows XP Home 

Recommended Configuration 

Recommended configuration is no more than 60 controllers and 120 readers for the system. Four port 
usages are suitable. Maximum users of no more than 500 users recommended in configuration.  In 
this case, it is good to have a separate PC to operate independently. It is recommended to use 
general PC mfrs and servers matching configurations below.  Memory expansion improves system 
functions therefore, having more memory is beneficial. 

 CPU: Pentium 4 or Higher 

 Memory:  256 Mb or Higher 

 HDD:  4 Gig or Higher 

 Port:  4 serial port (Needs Multi Port card)  or Higher 

 Network:  1 Ethernet card 

 OS: Microsoft Windows 2000 Professional or Windows XP Professional 
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Performance Configuration 

Performance configuration is no less than 60 panels and 240 readers for mid to large size system.  
Also, 8 ports or no less is suitable for operation.  Maximum users of no less than 500 users 
recommended in configuration.  In this case, it is good to have a separate PC to operate 
independently.  It is recommended to use general PC mfrs and servers matching configurations below.  
Memory expansion improves system functions therefore, having more memory is beneficial. 

 CPU:  Pentium 4 or Dual processors. 

 Memory:  512 Mb or Higher 

 HDD:  8 Gig or Higher 

 Port:  8 serial port (Needs Multi Port card)  or Higher 

 Network:  1 Ethernet card 

 OS:  Microsoft Windows 2000 server or Windows XP Professional 

Other Configuration (Network, Modem) 

Besides using serial communication, STARWATCH DUAL PRO I™ can use TCP/IP and Dial Up 
using a modem for communications. 

In TCP/IP communication, there is an external converter (NetEye 1000S) giving you 1 types of 
converters. 

To use TCP/IP communication, you will need an external converter and the PC has to be able to use 
the network. 

If using a modem, you need to use an external modem.  For assurance of tech support and device 
compatibility, we recommend 3 COM’s US Robotics 56K External Modem. 

For detailed explanation regarding TCP/IP and modem communication, please refer to chapter 7 
(TCP/IP communication) and chapter 8 (Dial Up communication).  
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System Specification For TCP/IP Loop 

System Specification For TCP/IP Loop 

  

TCP/IP Loop Network HUB Minimum (CPU,MEMORY,OS) Recomended (CPU,MEMORY,OS) 

10 and less switch , dummy P-III 866 , 128M , Win2000 Pro P-IV 2.0G , 256M . Win2000 Pro 

20 and less switch , dummy P-III 866 , 256M , Win2000 Pro P-IV 2.8G , 256M . Win2000 Pro 

30 and less switch P-IV 2.0G , 512M , Win2000 Pro P-IV HT 2.8G , 512M . Win2000 Server

50 and less switch XEON CPU , 512M , Win2000 Pro XEON DUAL CPU, 1G . Win2000 Server

70 and less switch XEON CPU , 512M , Win2000 Pro XEON DUAL CPU, 1G . Win2000 Server

99 and less switch XEON CPU , 1G , Win2000 Pro XEON DUAL CPU, 1G . Win2000 Server
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Chapter 

2 
STARWATCH DUAL PRO I 
Installation Environment 

STARWATCH DUAL PRO I™ Installation 
 
This chapter explains STARWATCH DUAL PRO I™ installation. 

STARWATCH DUAL PRO  I™ Installation 

Operating System 

The following is the STARWATCH DUAL PRO I™ installation OS. 

Microsoft Windows 2000 Professional Edition (SP4) 

Microsoft Windows 2000 Server Edition (SP4) 

Microsoft Windows XP Home Edition (SP2) 

Microsoft Windows XP Professional Edition(SP2) 

Also, it is not necessary, but we recommend installing Internet Explorer 6.  If you do not have this 
browser, you can download at Microsoft Web Site. 

http://www.microsoft.com/downloads/search.aspx?displaylang=en 

 

Microsoft Office 97 Program 

STARWATCH DUAL PRO I™ uses the Microsoft Access 97 database within the Microsoft Office 97 
application. 

Microsoft Office 97 program is not necessary, but for database and user operation, it makes it 
convenient.  (Microsoft Office XP installation works the same) 

Installation is recommended, if program is obtained. 

 

Installation 

Find the Setup.exe file in Install files folder of the software CD and select it to initialize its installation. 
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 As the following window shows on the screen, select “Next” in order to start the installation process. 

  
 
Select “I accept the terms in the System Requirement.” to accept the conditions of OS configuration.  

 
Select “Next” to install it in the default directory. In order to change its install directory, select” Change” 
and choose a folder to install the STARWATCH DUAL PRO I™.  

 

 

 

 

 

 

 

 

  Select a folder in the Program Folder to install the STARWATCH DUAL PRO I™. Use the defaulted 
name. Click ‘OK’ button. 



 
 
 
 
 
 

STARWATCH DUAL PRO I™ 

13 

  
 
Click “Install” to start its process. 

 

1) During the process it shows its status. Please wait.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2) If completed, it shows as below. Select “Finish” to finish it. 
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Chapter 

2 
  STARWATCH DUAL PRO I 
Structure 

STARWATCH DUAL PRO I ™ Structure 
 
This chapter explains STARWATCH DUAL PRO I™ structure.  It 
explains main screen structure, menu, standard icon, directory, and 
database file. 

STARWATCH DUAL PRO I™ Main Window 

STARWATCH DUAL PRO I™ main screen is differentiated into 4 parts. 

Top section consists of menu and tool bar, and middle contains screen activated by function.  Bottom 
section shows status, and through the main screen, the user can initiate functions quickly and 
efficiently. 
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Title bar and Menu 

Title bar and Menu 

 

Title bar shows program title and current version. 

Menu is categorized into 8 sections.  Each menu contains sub-menus, which the user can activate 
functions by selecting the correlating sub-menu. 

Menu Structure and Short Cut Key 

 Set Up 

It contains functions for communication relation, device definition, dial up setup, system log on (off), 
and quit. 

Title Bar and Menu 
Menu which allows practicing title of 
program and/or all functions of 
STARWATCH DUAL PRO I™ is 
existed. Able to practice only by 
contracted key, for that contracted key 
is set up at each menu. (contracted 
key table reference)  

Short Cut Icon 
Function used frequently is able to be 
practiced at once by setting up short cut 
icon. 

Program Area 
The screen of function selected in menu or short 
cut icon is shown in program practice area. The 
functions users want is executed through this 
area. 

Status Icons 
The date of computer, time and language selected 
currently etc. are shown. And log-in ID of log-in user 
is shown. 
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System Shortcut 
Key 

Set Up   ALT + S 

 Loop Definition  CTRL + A 

 Controller Definition  CTRL + B 

 Door/Reader Definition  CTRL + C 

 Map Definition  CTRL + R 

 Input/Output Definition Input/Output Point Definition CTRL + E 

  Input/Output Time schedule/Type Definition CTRL + F 

 System Set Time CTRL + G 

  Set Initialize CTRL + H 

  Mastercard Management  

 Dial-Up Chain Definition  CTRL + I 

 Logoff  CTRL + K 

 Quit  CTRL + Q 

 

 Database 

Database contains definition for company, department, title, area setup, map setup, user 
registration, management and options.  Inputting the default user data will be used in user 
management.  It also contains map function to setup by area and floor.  Database management 
contains backup, recovery, and compression for data. 
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Database Short Cut Key 

Database   ALT + D 

 Area/Floor Definition  CTRL + P 

 Company Definition  CTRL + L 

 Department Definition  CTRL + M 

 Title Definition  CTRL + N 

 Access Type Definition  CTRL + O 

 User Definition  CTRL + S 

 Database Management  CTRL + T 

 Option  CTRL + U 

  

 

 Access Control 

Access Control menu contains sub functions for managing access control.  It contains setup for 
work holiday, time schedule, user group, user management, and visitor management. 
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Access Control Short Cut Key 

Access Control   ALT + A 

 Holiday Definition  F2 

 Time schedule Definition Time Zone Definition F3 

  Time schedule Definition F4 

 Access Group Definition  F5 

 Card Holder Management  F6 

 Deleted Card(ID) Management  F7 

 Visitor Management  F8 

 

 View 

View menu contains access door control status, event transaction status, and communication 
status to monitor functions. 

 

View Short Cut Key 

View   ALT + V 

 Access Door Control/Status  CTRL + F1 

 Transaction Status  CTRL + F2 

 Communication Status  CTRL + F3 

 

 Report 

Report menu contains sub-menus for various reports.  You can have 8 types of access control 
reports. 
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Report Short Cut Key 
Report   ALT + R 

 Card Holder Report  CTRL + F4 

 Deleted Card Holder Report  CTRL + F5 

 Event History Report  CTRL + F6 

 Alarm History Report  CTRL + F7 

 Accessible Door Report for Individual  CTRL + F8 

 Accessible ID Report  for Door  CTRL + F9 

 Visitor Event History Report  CTRL + F11 

 Access Door Report By Registered 
Person 

  

 Registered Person Report By Access 
Door 

  

 Last Access Event Report  CTRL + F12 

 

 Time & Attendance  

Time & Attendance menu consists of sub-menus relating to the time attendance with the system.  
It contains definition for work time, work holiday, work type, data (daily, monthly, yearly) expiration, 
report, to operate functions easily. 

 

 

 



 
 
 
 
 
 

STARWATCH DUAL PRO I™ 

20 

Time / Attendance Short Cut 
Key 

Time/Attendance   ALT + T 

 Work Time Definition  SHIFT + F2 

 Work Holiday Definition  SHIFT + F3 

 Work Type Definition  SHIFT + F4 

 Time/Attendance Option 
Definition 

Management Mode Definition CTRL+V 

  Reader Definition CTRL+W 

  Function Key Definition CTRL+Y 
 Daily Data Management  SHIFT + F5 

 Monthly Data Management  SHIFT + F6 

 Yearly Data Management  SHIFT + F7 

 Break Time Management  SHIFT + F8 

 Report ID/Daily Attendance Report SHIFT + F9 

  Monthly/Yearly Attendance 
Report 

SHIFT + 
F11 

  Daily Break Time Report SHIFT+ 
CTRL+F1 

  Monthly Break Time Report SHIFT+ 
CTRL+F2 

 

 Window 

Window menu gives you options for horizontal or vertical viewing in a row. 

 

 

 

 Language 

Language menu contains multiple languages to change language of program for user. 

Window 

Window  

 Horizontal 

 Vertical 
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Language 

Language  

 Korean 

 English 

 User Language 1 

 User Language 2 

 User Language 3 

 User Language 4 

 User Language 5 

Shortcut Icon 

Shortcut icon lets the user perform frequently used functions to quickly initiate jobs. The black label to 
the right of shortcut icons displays current activity data of program operation. 

 

Here are the types of shortcut icons. 

Short Cut Icons 

 
Time Zone Create access time code and access time setup. 

 
Time schedule Setup time schedule by day of the week access time code. 

 
Access Group Create group in access area. 

 
Card Holder Input, edit, and delete card holder data. 

 
Visitor Input, edit, and delete visitor data. 

 
Transaction Monitor current event transaction in real time. 

 
Door Control Monitor door control status and manual control doors. 

 
Map Definition Setup item location and area/floor map definition. 
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Report Access control report inquiry and print out report. 

 
Language Language setup. 

 
Logoff Logoff from program. 

 
Quit Quit program 

 

Status bar 

Status bar displays current date and time setup in PC.  Also, it displays current language and user 
login ID. 

 

Standard Icon 

It explains standard icons used in STARWATCH DUAL PRO I™.  You can see general icons in every 
screens of STARWATCH DUAL PRO I™. These icons perform their specified functions.  The 
following explains each icon’s function. 

 

Standard Icon 1  

 
Find Finds the data by search condition. 

 
Add Used for adding data and activates additional screen. 

 
Modify Used in modifying data and activates modify screen. 

 
Delete Used in data deletion and deletes the data. 

 
Close Closes the current active screen. 

 

                       

Standard Icon 2 

 
Transmit Sends the current selected data to the controller. 

 
Batch Transmit Sends the searched data and database info in batch format. 
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Standard Icon 3 

 
Create Data Creates information result with original data. 

 

 

Standard Icon 4 

 
Print Searched information is printed out. 

 
Export Exports searched information text as Excel file format. 

Program Folder 

It explains the folder where STARWATCH DUAL PRO I™ is installed. 

STARWATCH DUAL PRO I™ is installed in C:\Program Files\ IDTECK \ STARWATCH DUAL PRO I. 

User can change the drive and folder, where program is installed.  During installation, it can 
install to other drive and folder if default folder is not used. 

Database Structure 

STARWATCH DUAL PRO I™ has 3 database files in structure, and all database file is created in 
Microsoft Access 97 file. But you can open a database file for reading a data, modifying a data in 
Access 2000, Access XP. Do not convert a database file to other database version (Access 2000, 
Access XP). 

The following is the database file creation. 

 STAR-ACS.mdb 

This database file contains all saved information of device data, user data, event current alarm 
data, and is the main database file of STARWATCH DUAL PRO I access control system. 

This file is the most important database file, and needs user’s management.  Refer to 
maintenance management chapter for detailed explanation. 

 

 STAR-TAS.mdb 
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This database file is STARWATCH DUAL PRO I™’s attendance file, and contains all saved 
information of time attendance, work holiday, work type, end of (day, month, year). 

This file is most important database file in attendance function, and needs user’s management. 

 STAR-LANGUAGE.mdb 

This multi language database file in STARWATCH DUAL PRO I™ contains all characters 
information displayed on screen in saved files. 

 

 

Chapter 

4 
 STARWATCH DUAL PRO I 
Initial Setup 

STARWATCH DUAL PRO I™ Initial Setup 
 
This chapter explains installation items setup, after installing 
STARWATCH DUAL PRO I™. 

Program Login 

The following screen appears in initial program activation.  Login gives program use authorization, 
and if this is first time login after installation, you will need to use default login information.  

 
 

 
Once the login screen appears, input admin for User ID. Password does not exist. Then press Enter 
or select Login button to go to main screen. 
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Program Configuration 

Area/Floor Definition 

Area/Floor configuration is used for default data creation to distinguish access door, reader, and 
sensors by installed locations.  Multiple buildings can be designated by area, and the floors correlating 
to the area can be distinguished. 

 Start 

Select Database->Area/Floor definition or press Ctrl+P on keyboard. 

 

 

 Add 

Add is used to create the new data.  Select Add to input data of area and floor through the input 
screen. 

  

1) Select Add and the screen below appear. 
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2) Input area code.  If already registered code is used, it will not register, but only a new area code. 

3) Input area name. 

Select floor then select Add button.  It will show up in Floor List window.  Repeat this procedure to 
add additional floors. 

4) If all the floors are added to the area, select Save button to save. 

5) Select Close to finish. 

Setup the area/floor definition prior to use, because the data is used in variety of ways for 
registration of access door, reader, input point of contact, and map configuration. 

  

Loop Definition 

Port definition describes Serial and TCP/IP communication loop connected to the PC.  It supports up 
to 99 Loops, but keep in mind depending on PC performance, memory, and OS, supporting 99 Loops 
may not be possible.  It is recommended to use adequate number of Loops for usage. 

 Start 

Select Set Up-> Loop Definition or press Ctrl+A button on keyboard. 

 

 Find 
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Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to edit and delete the existing data information. 

  

1) Select Loop No. and Comm. Type as appropriate. 

2) Select Find to make an inquiry.  If inquired result is available, the following screen appears. 

 

 

If find has no specific parameters, it will display the entire information 

Find Add, Modify and Delete functions are all applied equally in input/output screen.  Once 
you familiarize these functions, you can easily understand them as they are used equally in 
other input/output screens. 

 Add 

Add is used to create new data.  Select Add button to add work type data through input screen. 
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1) Select Add button and the following screen appear. 

 

2) Select Loop No and it will indicate Loop No not used.  The Loop No. being used will not be 
displayed. 

3) Select Comm. Type as Serial Chain for Serial, TCP/IP Chain for TCP/IP and Dial-UP Chain for 
Dial-Up as communication type. 

4) Check mark Active for the correspond port to be able to communicate. 

Decide if correspond port will be active for communication.  Active check mark Loop No 
communicates, but without a check mark will result in no communication. 

This option lets the user make the port inactive, if the port requires maintenance due to a 
problem in communication.  User can fix the problem while other locations remain with active 
ports. 
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If the port data is modified, you must close the program and restart. 

5) Select from Serial Chain tab, Comm. Port, Speed, Parity Bit, Data Bit, and Stop Bit.  The default 
value is Speed 9600, Parity Bit None, Data Bit 8, and Stop Bit 1 for configuration. 

6) Input screen changes if TCP/IP Chain is selected. 

 

Input the IP Address from the external converter for configuration. 

Input TCP Loop No. as default value 5000. (Port No. is fixed at 5000) 

Select Module Type as external version. 

For detailed instructions on TCP/IP communication, refer to chapter 7 STARWATCH DUAL PRO 
I™ TCP/IP Communication. 

7) Input screen changes if Bypass TCP/IP Chain is selected. 
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      Bypass TCP/IP Chain is used when connecting with WebEye Device. 

      To use Surveillance monitoring, WebEye Device should be used. 

      WebEye Device can not only connect with camera and also can communicate 

      Like converter. So if you want to use WebEye Device there are couple of things 

      to input. 

      WebEye Device is communicate by TCP/IP, so you should input IP Address, Port  

      No. And Device ID, Device Password, Com Port, Speed, Parity Bit, Data Bit, Stop bit. 

      We recommend to read View Pro Installation Guide about detail information. 

8) Select Save button to save  data, and select Close button to finish. 

 Modify 

Modify is used to change existing data.  Find data to modify or to change registered work time 
category. 

Selected data is displayed as below figure in highlighted bar. 
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1) Select Modify to see the above screen.  The Port List is equal to registration screen.  Therefore, 
the Loop No. cannot be modified. 

 

2) Modify the items that need changing.  Once completed, select Save button to save the modify 
data.  

3) Select Close button to finish. 

 Delete 

Delete is used to delete existing data.  Find data to delete or to delete registered category list data. 

Selected data is displayed as below figure in highlighted bar. 
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1) Select Delete button.  The screen below will appear.  Select Yes button to delete or No button to 
cancel. 

 

Deleting the registered port will erase all data of controller, access door, and reader.  Please 
use extreme caution when using this function. 

 

Controller Definition 

Controller Definition explains data definition of controller 

Each device has its own communication address.  By address type, the S/W data is defined and 
communicated.  Also, each device can have its own function options, and these options are sent to the 
devices for application. 

 Start 

Select Set Up->Controller Definition or press Ctrl+B button on keyboard. 

 Add 

1) Add is used to create the new data.  Select Add to add controllers through the input screen 



 
 
 
 
 
 

STARWATCH DUAL PRO I™ 

33 

 

2) Select Add and the following screen appear. 

 

 

 

 

 

 

 

 

 

 

 

3) Select Loop No.  It will display the Loop numbers from Loop registration. 

4) Controller numbers not registered will be displayed in Unregistered Controller No. List.  Select the 
Controller No. to register by selecting >> button or double clicking the controller number to add to 
the right hand side Registered Controller No. List window. 
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Controller registration must be done one at a time.  This means after registering one controller 
number, you need to input the controller’s default data.  Once this is done, select Save button 
to save this controller’s definition to finish.  Repeat the procedure to add additional controllers. 

5) Select Controller Type as controller type. 

 

6) Select Door Type as 1 Door for operation. 

7) Input Controller Name.  It must be done because it is used to locate which controller is having the 
event when an event occurs. 

8) Card memory definition is setup.  The event memory is automatically defined depending on card 
memory.  Define adequate card and event memory for operation. 

9) Controller Default value is optional (It is not necessary for operation) 

10) Select Save button to save data. 

11) Select Close button to finish. 

 

Biometric Reader Definition 

 

Biometric Reader Definition defines Biometric Reader connected to the Controller. To transmit user’s 
fingerprint or manage reader it is required to setup Biometric Reader items. To transmit user’s fingerprint 
and manage reader Biometric Reader it needs to be  composed with communication line and Biometric 
Reader should have address over 33. And reader address cannot have the same address with controller 
which connected to the same Port. . Refer to the Biometric Reader manual to setup. In this menu you 
can manage reader setup and reader function. 

Available function :  

FGR006 : Reader Mode , Fingerprint Mode , Adaptive Mode, Output Mode, Function Mode, 
Identification 

FINGER006 : Reader Mode , Fingerprint Mode , Adaptive Mode, Identification, LCD Display, Key Pad, 
Finger006P, Output Mode, Output Type, Input Mode 
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Reader Mode  

Card Reading Mode of Biometric Reader.  

RF Only, Through card reading, card number is transmitted to the controller. 

RF+FINGER, After card reading, fingerprint is confirmed. Both card reading and fingerprint 
confirmation are finished then card number is transferred to the controller.  
If scanning for fingerprint is not working after reading card the user is not registered 
fingerprint. And after confirmation of fingerprint the door is not opened then either confirmation 
of fingerprint is failed or confirmation of controller is failed. 

Confirmation failure : Unregistered User. 

 

Fingerprint Mode 

 Set up the count of fingerprint in Biometric Reader. 

In Single mode. you  should register fingerprint of one person two times.  
This makes the security rate of confirmation of fingerprint higher. 

In Dual Mode, fingerprints of different finger are registered separately.  
It is allowed to register one fingerprint two times.  
Dual Mode is for replacing broken fingerprint with second registered fingerprint. 

 

Adaptive Mode 

Used to make scanning rate higher. Not to make Confirmation rate higher.  
In Use Scanning module flicking.  
In Not Use Scanning module is on continuously. 

 

Output Mode 

Set up card data print type which transmit from Biometric Reader to the controller. 

This is the way transmitting  Card number in RF Only or RF + FINGER in Biometric Reader. 
Set up controller’s receipt reader type which receive card number. 

0 – 26 Bit Wiegand , 1 – ABA Track II (10  Char) 
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Must setup 0 – 26 Bit Wiegand  in Controller. 

  

Function Mode 

Setup Biometric reader’s function. 

Reader Mode is to read card and confirm fingerprint. 

Reg Mode is same with the registration of  fingerprint reading Master Card.  
When using this mode automatically changed to the fingerprint registration mode.   
After finishing fingerprint registration and deletion to use normally you should change to the 
Reader Mode. 

 

Identification 

This is Automatch function. This function makes it possible to grant cardholder verification 
only by fingerprint without card.  

If mode is Not Use, according to mode cardholder should verify by card or card + fingerprint.  

If mode is Use, it is possible to verify only by fingerprint without card or pin input.  

        

LCD Display 

This function is to show cardholder card verification status or card number.  

In Status mode, it displays verified status or not verified status after card or fingerprint 
verification has finished.  

In Use mode, it displays only card number regardless of verification success or verification 
failure.  

 

Key Pad 

This function is to set whether Key  Pad will be used or not.  
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In Use mode, it is possible to verify card by using Key Pad. 

In Not Use mode, it is not possible to verify card by using Key Pad. Key pad won’t be 
operated.  

 

Finger006P 

This function is to set whether PIN mode will be used or not in Finger006. It will be set 
automatically and user won’t be allowed to use this mode. So don’t change this mode as you 
please.  

In Use mode, it will displayed as FINGER006P on LCD screen and this makes it possible to 
verify cardholder just by inputting Pin number. 

In Not Use mode, PIN mode will not be set.  

 

 Start 

System -> Click Biometric Reader Definition. Or Press CTRL+C 

 Add 

Add is used to make new data. When adding Biometric Reader Click Add and insert a new data. 
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1) Click Add. Biometric Reader registration form is loaded. 

  

2) Choose Loop number which connected to Biometric Reader. In Loop Registration only 
registered Loop numbers are shown. 

3) Biometric Reader number which is not contained to the chosen Loop is shown to the 
Unregistered Biometric Reader No. In left side choose Biometric Reader number and click >> or 
double-click Biometric Reader then Biometric Reader numbers are registered to the right side 
Registered Biometric Reader No. 

Biometric Reader Registration should be setup once at a time.  

After Registering one Biometric Reader number, insert all the basic data.  Insert is done then 
click save to finish setting up Biometric Reader. 

Add Biometric Reader and set up continuously as above explanation. 

4) Choose Biometric Reader type. 

5) Insert Biometric Reader name. This is used in Door/Reader Setup. 

6) Set up Biometric Reader function.  
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7) To apply the items to the Biometric Reader after saving items click Transmit button. 

8) Click Save to save items.  

9) Click Close to exit.  

10) Set up all the items of added Biometric Reader as above. 

11) There are 3 tabs you can choose.  

In ‘Select Biometric Reader’ If you select FGR006 then FGR006 tab will be enabled. Select 
Reader Mode, Fingerprint Mode, Adaptive Mode, Output Mode, Function Mode and Click ‘Save’ 
button to save the data. 

If you select FINGER006 then FINGER006 tab will be enabled. Select Reader Mode, Fingerprint 
Mode, Adaptive Mode, Identification, LCD Display, Keypad and Click ‘Save’ button to save the 
data 

‘Set Initialize’ tab is used to initialize system or card data of Biometric reader. Select one to 
initialize and click ‘Save’ button to save the data. 

 Modify 

Modify is used to change saved data. Through Find function find data or choose data which will be 
modified. 

       Selected data is displayed as blue bar as below. 

 

1) Biometric Reader’s Modify form is displayed. Biometric Reader’s Modify form should be same with 
Registration form but Loop number cannot be changed and only chosen one Biometric Reader 
address can be changed. 



 
 
 
 
 
 

STARWATCH DUAL PRO I™ 

40 

2) Modify items to modify. 

3) Click Save button to save modified data. 

4) Click Transmit button to transmit data to the Biometric Reader. 

  

5) Click Close to exit. 

6) Modify items of added Biometric Reader as above. 

 

 Delete 

Delete is used to delete saved Biometric Reader data. 
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1) Click Delete. After clicking Delete, Delete confirmation form is loading. To Delete click Yes 
and not to delete click No. 

 

 Transmit 

Transmit is to send inserted data to the Biometric Reader so that Biometric Reader can work 
properly. 

 

1) When transmitting through Find function find the data to transmit or choose Biometric Reader 
to transmit in saved Biometric Reader List. 

2) Click Transmit. Through clicking transmitting chosen items are transmitted to the Biometric 
Reader and applied. 

3) If transmission error does not occur  Completed message pops up. 
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4) If error occurs message box displays the error message. In this case it needs to check 
Biometric Reader error or Communication status. 

 
 

Door/Reader Definition 

Door/Reader definition explains door and reader data.  Door and reader are connected to each 
controller.  Therefore, S/W needs to be defined regarding the door and reader data to control event 
occurrence and controller. 

 Start 

Select Set Up->Door/Reader Definition or press Ctrl+C button on keyboard. 

 Add 

Add is used to create the new data.  Select Add to add Door/Reader data through the input 
screen. 

 

1) Select Add button and the following screen appear. 
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2) Select Loop No. and Controller No. 

3) Anti-Pass back is configured. (For detailed explanation, refer to STARWATCH DUAL PRO I™ 
initial setup) 

4) Input Door Info with area, floor, and name.  Area and floor data is according to current installed 
access doors. (Configure the area/floor of access door through Database->Area/Floor Definition) 

For Door Name, input easily identified name for definition. 

5) Access door contact type and lock type is optional. 

6) Select Duress Mode if to be used, and input a 2-digit password to use Duress. 

7) Input data for Reader (In) and Reader (Out). 

For Reader Name, input easily identified name for definition. 

For Reader Mode, select reader mode for operation. 

For all time schedules upon selecting card + pw(fingerprint) ID selection, you can configure to use 
depending on time to use card ID or card + pw(fingerprint) ID in specified time to change  
automatically. (This function is connected to time schedule; for detailed explanation, refer to 
STARWATCH DUAL PRO I™ initial setup) 

Configure Reader (In) and Reader (Out), if using 1 access door with 2 readers as In and Out, 
but if using only 1 reader, configure Reader (In) only. 

Reader (In) is controller and reader (Out) is exit reader. 

8) Select Save button to save. 
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9) Select Close button to finish. 

Antipassback  

Antipassback is the function when In/Out data of user is agreed upon to be given 
authorization for access. 

To use Antipassback, each door needs In/Out reader for operation.  If the card was 
read going in, the same system needs to read it going out.  If the card was not read 
going into the room, you cannot leave the room.  Same apply, if the card was not read 
going out of the room, you cannot go into the room. 

Zone, Global Antipassback – Access control via controller connected to 2 or more 
system configuration.  2 or more readers act as set (In/Out reader) to grant access 
when In/Out data is agreed. 

 

Duress Mode  

Duress mode lets the user gain access when forced upon, by using the 2-digit pass code to 
activate the internal silent alarm during a duress event occurrence. 

 

 

Reader Mode 

Sends the configuration to the system of how the readers will be used. 

For example, if sending as RF +Password mode, the time schedule and reader mode are 
activated.  It will operate in RF only mode during applied time schedule and RF + Password 
mode outside the applied time schedule. 

 

Once the communication configuration and reader registration is completed, you will need to 
exit the program and re-enter through login for the configurations to be applied. 

Once the program is restarted, if the configurations are accurate, the controller and program 
will be communicating.  Check the status by communication status. If communication is not 
established, follow the steps below to check. 

Check the agreement of program configuration with device. 
Check device address configuration. 
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Initialize device. 
Check communication cable connection. 
Check converter. 

Check communication port configuration of PC, whether configured correctly and activating. 

 

 

STARWATCH DUAL PRO I™ Access Control 
 
This chapter explains specific instructions on Access Control functions 
in STARWATCH DUAL PRO I™ 

Set Up 

System contains communications, controller, and directly related functions.  Configurations are setup 
for communication port, controller data, reader, door, and various data.  Also, the setup values are 
sent to the controller for application. 

System related functions are to proceed after controller and S/W initial installation, and these functions 
are not used frequently, but plays a critical part during initial setup. 

 

Loop Definition 

Port definition describes Serial and TCP/IP communication loop connected to the PC.  It supports up 
to 99 Loops, but keep in mind depending on PC performance, memory, and OS, supporting 99 Loops 
may not be possible.  It is recommended to use adequate number of Loops for usage. 

 Start 

Select Set Up-> Loop Definition or press Ctrl+A button on keyboard. 

Chapter 

5 
  STARWATCH DUAL PRO I 
Access Control 
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 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to edit and delete the existing data information. 

  

3) Select Loop No. and Comm. Type as appropriate. 

4) Select Find to make an inquiry.  If inquired result is available, the following screen appears. 

If find has no specific parameters, it will display the entire information 

Find Add, Modify and Delete functions are all applied equally in input/output screen.  Once 
you familiarize these functions, you can easily understand them as they are used equally in 
other input/output screens. 

 

 Add 

Add is used to create new data.  Select Add button to add work type data through input screen. 
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1) Select Add button and the following screen appear. 

 

2) Select Loop No and it will indicate Loop No not used.  The Loop No. being used will not be 
displayed. 

3) Select Comm. Type as Serial Chain for Serial, TCP/IP Chain for TCP/IP and Dial-UP Chain for 
Dial-Up as communication type. 

4) Check mark Active for the correspond port to be able to communicate. 

Decide if correspond port will be active for communication.  Active check mark Loop No 
communicates, but without a check mark will result in no communication. 

This option lets the user make the port inactive, if the port requires maintenance due to a 
problem in communication.  User can fix the problem while other locations remain with active 
ports. 
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If the port data is modified, you must close the program and restart. 

5) Select from Serial Chain tab, Comm. Port, Speed, Parity Bit, Data Bit, and Stop Bit.  The default 
value is Speed 9600, Parity Bit None, Data Bit 8, and Stop Bit 1 for configuration. 

6) Input screen changes if TCP/IP Chain is selected. 

 

Input the IP Address from the external converter for configuration. 

Input TCP Loop No. as default value 5000. (Port No. is fixed at 5000) 

Select Module Type as external version. 

For detailed instructions on TCP/IP communication, refer to chapter 7 STARWATCH DUAL PRO 
I™ TCP/IP Communication. 

7) Input screen changes if Bypass TCP/IP Chain is selected. 
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      Bypass TCP/IP Chain is used when connecting with WebEye Device. 

      To use Surveillance monitoring, WebEye Device should be used. 

      WebEye Device can not only connect with camera and also can communicate 

      Like converter. So if you want to use WebEye Device there are couple of things 

      to input. 

      WebEye Device is communicate by TCP/IP, so you should input IP Address, Port  

      No. And Device ID, Device Password, Com Port, Speed, Parity Bit, Data Bit, Stop bit. 

      We recommend to read View Pro Installation Guide about detail information. 

8) Select Save button to save  data, and select Close button to finish. 

 Modify 

Modify is used to change existing data.  Find data to modify or to change registered work time 
category. 

Selected data is displayed as below figure in highlighted bar. 
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1) Select Modify to see the above screen.  The Port List is equal to registration screen.  Therefore, 
the Loop No. cannot be modified. 

 

2) Modify the items that need changing.  Once completed, select Save button to save the modify 
data.  

3) Select Close button to finish. 

 Delete 

Delete is used to delete existing data.  Find data to delete or to delete registered category list data. 

Selected data is displayed as below figure in highlighted bar. 
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2) Select Delete button.  The screen below will appear.  Select Yes button to delete or No button to 
cancel. 

 

Deleting the registered port will erase all data of controller, access door, and reader.  Please 
use extreme caution when using this function. 

Controller Definition 

Controller Definition explains data definition of controller.  Each controller has its own communication 
address.  By address type, the S/W data is defined and communicated.  Also, each controller can 
have its own function options, and these options are sent to the controllers for application. 

Complete all initial setup and reboot the program, and make certain communication is established 
before using transmit function. 

 Start 

Select Set Up->Controller Definition or press Ctrl+B button on keyboard. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to edit and delete the existing data information. 
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1) Select Loop No. and Controller No. as appropriate. 

2) Select Find to make an inquiry.  If inquired result is available, it will display the results. 

If find has no specific parameters, it will display the entire information  

 Add 

Add is used to create new data.  Select Add button to add work type data through input screen. 

 

1) Select Add button and the following screen will appear. 
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2) Select Loop No.  It displays only the Loop No. that was registered in Loop Registration. 

3) Unregistered Controller No. List displays items not selected from Loop No.  Select the Controller 
No. to be registered choosing and selecting >> button or double click the Controller No. to select 
and it will show up on the right hand side Registered Controller No. List.  

Controller registration must be done one at a time to setup.  

It will register one controller number with its basic data for configuration.  Select Save button 
to complete the process. 

Repeat the procedure to add additional controllers. 

4) Select Controller Type as controller type.  

5) Input Controller Name.  This is a must in order to define the location, when an event occurs to a 
controller. 

6) Configure card memory.  Depending on card memory setup, the event memory is automatically 
setup.  Configure adequate amount of card and event memory. 

7) After setup is completed in ‘Set Card ID Memory’, please click ‘Function Setting’ tab. Following 
screen will be shown up. 
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8) These items in ‘Function Setting’ is Type in Controller and user can select the type.  

A. Stand Alone is used to select whether new data will be filed or ignored when memory 
is full. Default value is ‘Not Use’ 

B. Finger007P is used to select whether Pin mode will be activated or no. Default value 
is ‘Not Use’ 

C. Dual Finger is used to register fingerprint in registration mode whether single 
fingerprint is used or dual fingerprints are used. Default value is ‘Not Use’ 

D. Adaptive Mode is used to enhance fingerprint verification rate. Default value is ‘Use’ 

E. Identification is used to access door only by fingerprint. Default value is ‘Not Use’ 

F. LCD Display is to select whether access status will be shown up or card number will 
be shown up. Default value is ‘Status’ 

G. You can set Output Time 1Sec or 0.1Sec. Default value is 1Sec. 

9) Select Save button to save data. 

10) Select Transmit button to send setup data to controller for memory setup. 

When setup is performed for all controller, program, and related data, it is not active until 
transmitted to controller.  It is possible the transmit function may not work properly.  

11) Select Close button to finish. 

 Modify 

Modify is used to change existing data.  Find data to modify or to change registered controller 
category. Selected data is displayed as below figure in highlighted bar. 
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1) Select Modify to see the following screen.  The Controller Modify is equal to registration screen.  
However, the Loop No cannot be changed, and modify is possible to the selected controller 
address. 

A. 

  

B. 
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Modify the items that need changing. And 505R and ICON100 can be changed only LCD Display 
and Output Time in ‘Function Setting’. 

2) Select Save button to save the modified information.   

3) Select Transmit button to send setup data to controller for memory setup. 

When setup is performed for all controller, program, and related data, it is not active until 
transmitted to controller.  It is possible the transmit function may not work properly. 

4) Select Close button to finish. 

 Delete 

Delete is used to delete existing saved data.  Find data to delete or to delete registered controller 
category data. Selected data is displayed as below figure in highlighted bar. 
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1) Select Delete button.  The screen below will appear.  Select Yes button to delete or No button to 
cancel. 

 

Deleting the registered controller will erase all data of controller, access door, and reader.  
Please use extreme caution when using this function. 

 Transmit 

This function is used to send the setup functions to the controller for activation.  Use Find to 
search for data transmit or select the data from the registered controller categories to send. 

Selected data is displayed as below figure in highlighted bar. 
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1) Select Transmit button.  This will send the selected data to the corresponding Controller No for 
application. 

If an error does occur, detailed explanation is displayed in a message box. 

In this case, retransmit the data, but if the error continues, check the communication and 
controller for problems. 

Biometric Reader Definition 

 

Biometric Reader Definition defines Biometric Reader connected to the Controller.          To transmit 
user’s fingerprint or manage reader it is required to setup Biometric Reader items. 

 

To transmit user’s fingerprint and manage reader Biometric Reader it needs to be  composed with 
communication line and Biometric Reader should have address over 33. And reader address cannot 
have the same address with controller which connected to the same Port. . Refer to the Biometric 
Reader manual to setup. 

 

In this menu you can manage reader setup and reader function. 

Available function :  

FGR006 : Reader Mode , Fingerprint Mode , Adaptive Mode, Output Mode, Function Mode, 
Identification 

FINGER006 : Reader Mode , Fingerprint Mode , Adaptive Mode, Identification, LCD Display, Key Pad, 
Finger006P, Output Mode, Output Type, Input Mode 
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Reader Mode  

Card Reading Mode of Biometric Reader.  

RF Only, Through card reading, card number is transmitted to the controller. 

RF+FINGER, After card reading, fingerprint is confirmed. Both card reading and 
fingerprint confirmation are finished then card number is transferred to the 
controller.  
If scanning for fingerprint is not working after reading card the user is not registered 
fingerprint. And after confirmation of fingerprint the door is not opened then either 
confirmation of fingerprint is failed or confirmation of controller is failed. 

Confirmation failure : Unregistered User. 

 

Fingerprint Mode 

 Set up the count of fingerprint in Biometric Reader. 

In Single mode. you  should register fingerprint of one person two times.  
This makes the security rate of confirmation of fingerprint higher. 

In Dual Mode, fingerprints of different finger are registered separately.  
It is allowed to register one fingerprint two times.  
Dual Mode is for replacing broken fingerprint with second registered fingerprint. 

 

Adaptive Mode 

Used to make scanning rate higher. Not to make Confirmation rate higher.  
In Use Scanning module flicking.  
In Not Use Scanning module is on continuously. 

 

Output Mode 

Set up card data print type which transmit from Biometric Reader to the controller. 

This is the way transmitting  Card number in RF Only or RF + FINGER in Biometric 
Reader. Set up controller’s receipt reader type which receive card number. 
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0 – 26 Bit Wiegend , 1 – ABA Track II (10  Char) 

Must setup 0 – 26 Bit Wiegend  in Controller. 

  

Function Mode 

Setup Biometric reader’s function. 

Reader Mode is to read card and confirm fingerprint. 

Reg Mode is same with the registration of  fingerprint reading Master Card.  
When using this mode automatically changed to the fingerprint registration mode.   
After finishing fingerprint registration and deletion to use normally you should change 
to the Reader Mode. 

 

Identification 

This is Automatch function. This function makes it possible to grant cardholder 
verification only by fingerprint without card.  

If mode is Not Use, according to mode cardholder should verify by card or card + 
fingerprint.  

If mode is Use, it is possible to verify only by fingerprint without card or pin input.  

        

LCD Display 

This function is to show cardholder card verification status or card number.  

In Status mode, it displays verified status or not verified status after card or 
fingerprint verification has finished.  

In Use mode, it displays only card number regardless of verification success or 
verification failure.  
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Key Pad 

This function is to set  whether Key  Pad will be used or not.  

In Use mode, it is possible to verify card by using Key Pad. 

In Not Use mode, it is not possible to verify card by using Key Pad. Key pad won’t be 
operated.  

 

Finger006P 

This function is to set whether PIN mode will be used or not in Finger006. It will be 
set automatically and user won’t be allowed to use this mode. So don’t change this 
mode as you please.  

In Use mode, it will displayed as FINGER006P on LCD screen and this makes it 
possible to verify cardholder just by inputting Pin number. 

In Not Use mode, PIN mode will not be set.  

 Start 

System -> Click Biometric Reader Definition. Or Press CTRL+C 

 Add 

Add is used to make new data. When adding Biometric Reader Click Add and insert a new data. 
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12) Click Add. Biometric Reader registration form is loaded. 
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13) Choose Loop number which connected to Biometric Reader. In Loop Registration only 
registered Loop numbers are shown. 

14) Biometric Reader number which is not contained to the chosen Loop is shown to the 
Unregistered Biometric Reader No. In left side choose Biometric Reader number and click >> or 
double-click Biometric Reader then Biometric Reader numbers are registered to the right side 
Registered Biometric Reader No. 

Biometric Reader Registration should be setup once at a time.  

After Registering one Biometric Reader number, insert all the basic data.  Insert is 
done then click save to finish setting up Biometric Reader. 

Add Biometric Reader and set up continuously as above explanation. 

15) Choose Biometric Reader type. 

16) Insert Biometric Reader name . This is used in Door/Reader Setup. 

17) Set up Biometric Reader function.  

18) To apply the items to the Biometric Reader after saving items click Transmit button. 

19) Click Save to save items.  

20) Click Close to exit.  

21) Set up all the items of added Biometric Reader as above. 

22) There are 3 tabs you can choose.  

In ‘Select Biometric Reader’ If you select FGR006 then FGR006 tab will be enabled. Select 
Reader Mode, Fingerprint Mode, Adaptive Mode, Output Mode, Function Mode and Click ‘Save’ 
button to save the data. 

If you select FINGER006 then FINGER006 tab will be enabled. Select Reader Mode, Fingerprint 
Mode, Adaptive Mode, Identification, LCD Display, Keypad and Click ‘Save’ button to save the 
data 

‘Set Initialize’ tab is used to initialize system or card data of Biometric reader. Select one to 
initialize and click ‘Save’ button to save the data. 

 Modify 

Modify is used to change saved data. Through Find function find data or choose data which will be 
modified. 

       Selected data is displayed as blue bar as below. 
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7) Biometric Reader’s Modify form is displayed. Biometric Reader’s Modify form should be same with 
Registration form but Loop number cannot be changed and only chosen one Biometric Reader 
address can be changed. 

8) Modify items to modify. 

9) Click Save button to save modified data. 

10) Click Transmit button to transmit data to the Biometric Reader. 
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11) Click Close to exit. 

12) Modify items of added Biometric Reader as above. 

. 

 

 Delete 

Delete is used to delete saved Biometric Reader data. 

 

1) Click Delete. After clicking Delete, Delete confirmation form is loading. To Delete click Yes 
and not to delete click No. 

 

 Transmit 

Transmit is to send inserted data to the Biometric Reader so that Biometric Reader can work properly. 
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5) When transmitting through Find function find the data to transmit or choose Biometric Reader 
to transmit in saved Biometric Reader List. 

6) Click Transmit. Through clicking transmitting chosen items are transmitted to the Biometric 
Reader and applied. 

7) If transmission error does not occur  Completed message pops up. 

8) If error occurs message box displays the error message. In this case it needs to check 
Biometric Reader error or Communication status. 

 

Door/Reader Definition 

Door/Reader definition explains door and reader data.  Door and reader are connected to each 
controller.  Therefore, S/W needs to be defined regarding the door and reader data to control event 
occurrence and controller. 

 Start 

Select Set Up->Door/Reader Definition or press Ctrl+C button on keyboard. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to edit and delete the existing data information. 
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1) Select Loop No. and Controller No. as appropriate. 

2) Select Find to make an inquiry. If inquired result is available, the following screen appears. 

If find has no specific parameters, it will display the entire information 

 Add 

Add is used to create new data.  Select Add to add Door/Reader data through the input screen. 

 

1) Select Add button and the following screen appear. 
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2) Select Loop No. and Controller No. 

3) Anti-Passback is configured. (For detailed explanation, refer to chapter 4 STARWATCH DUAL 
PRO I™ initial setup) 

4) Input Door Info with area, floor, and name.  Area and floor data is according to current installed 
access doors. (Configure the area/floor of access door through Database->Area/Floor Definition) 

For Door Name, input easily identified name for definition. 

5) Access door contact type and lock type is optional. 

6) Select Duress Mode if to be used, and input a 2-digit password to use Duress. 

7) Input data for Reader (In) and Reader (Out). 

For Reader Name, input easily identified name for definition. 

For Reader Mode, select whether using card ID or card + pw for operation.  (You will need keypad 
reader to use this setup) 

For all time schedules upon selecting card + pw ID selection, you can configure to use depending 
on time to use card ID or card + pw ID in specified time to change automatically. (This function is 
connected to time schedule; for detailed explanation, refer to chapter 4 STARWATCH DUAL PRO 
I™ initial setup) 

8) Select Save button to save. 

9) Select Transmit button to transmit setup data to controller for Antipassback Set up, Duress Mode, 
Reader Mode and Reader Mode Time schedule. 

When setup is performed for all controller, program, and related data, it is not active until 
transmitted to controller.  It is possible the transmit function may not work properly.  

10) Select Close button to finish.  



 
 
 
 
 
 

STARWATCH DUAL PRO I™ 

69 

 

 Modify 

Modify is used to change existing data.  Find data to modify or to change registered reader 
category. 

Selected data is displayed as below figure in highlighted bar. 

 

1) Select Modify to see the following screen.  The Reader/Door Definition is equal to registration 
screen.  However, the Loop No and Controller No cannot be modified. 

  

2) Modify category that needs changing.  Once completed, select Save button to save modified data. 

3) Select Transmit button to send setup data to controller. 

When setup is performed for all controller, program, and related data, it is not active until 
transmitted to controller.  It is possible the transmit function may not work properly. 
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Complete all initial setup and reboot the program, and make certain communication is 
established before using transmit function. 

4) Select Close button to finish. 

 Delete 

Delete is used to delete existing data.  Find data to delete or to delete registered data. 

Selected data is displayed as below figure in highlighted bar. 

  

1) Select Delete button.  The screen below will appear.  Select Yes button to delete or No button to 
cancel. 

 

 

 Transmit 

This function is used to send the setup functions to the controller for activation.  Use Find to 
search for data transmit or select the data from the registered reader categories to send. 

Selected data is displayed as below figure in highlighted bar. 
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a. Select Transmit button.  This will send the selected data to the corresponding Controller No for 
application. 

If an error does occur, detailed explanation is displayed in a message box. 

In this case, retransmit the data, but if the error continues, check the communication and 
controller for problems. 

 

Input/Output Definition 

In/Output Definition configures signal activation for specific outputs when an input signal occurs.  It 
also sets how long in seconds the output signal will activate.  

It is also possible to setup a user preferred text display, when an input signal type occurs. 

Depending on Input/Output controller type setup, the data in reference to Input/Output signal using 
controller default value is automatically created and stored in the database.   

For this reason, the user does not have to Add or Delete, but the Input/Output signal, activated time, 
and point of input can be modified and transmitted. 

Input/Output data are automatically selected based on controller type entered from controller 
set up. 

This data is registered by default setting value of controller. Only modification is available to 
change setting value of input/output and download modified data to control. 

Refer hardware manual to setting default value for input/out based on controller type. 

 Start 
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Select Set Up->Input/Output Definition List or press shortcut key Ctrl+E. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to edit and delete the existing data information. 

 

1) Select Loop No. and Controller No. as appropriate. 

2) Select Find to make an inquiry.  If inquired result is available it will display the results. 

If find has no specific parameters, it will display the entire information 

 Modify 

Input/Output Point is automatically setup in default value depending on controller type.  However, 
if the user modifies the Input/Output status, you can activate the Point differently.  

Select the Input Point of the controller to be modified.  Selected data is highlighted.  
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1) Select Modify button. 

2) Input Point sets which outputs of the controller occur from receiving the input signal from the 
controller. 

Also, when an Input Point type and corresponding Input Point occurs, the text display and 
specified time of signal occurrence success or failure can be setup. 

  

3) Select Area and Floor Location.  Selecting the location of input signal occurrence lets the user 
check where the event location occurred. 

4) For Input Point name, input the letters displayed in the event window that corresponds to the input 
signal occurrence. 

5) Decide which outputs will activate in Output 1-5, when an input signal occurs.  The input value for 
the Output is setup in seconds. 
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00 sec for input will result in no signal for the corresponding output.  Selecting from 01-99 sec will 
let the output activate for specified seconds. 

6) Select Save button to save. 

7) Select Transmit to send to controller. 

When setup is performed for all controller, program, and related data, it is not active until 
transmitted to controller.  It is possible the transmit function may not work properly. 

8) Select Close button to finish. 

Normal setting defines input form other controllers which are connected to controller can be 
changed by user. However, some of specific setting input values are fixed as exit and door 
contact depends on controller type. (Refer hardware manual for detail) 

Advanced set-up dose not accept signal from other controllers selected by user. Because 
advanced set up is fixed for internal input signal, specific value must be received.    

Therefore, Input type or name can not be entered when user modifies advanced set up. 

Modification of advanced set up allows changing activation time based on input signal 

In/Output Time schedule & Signal Type 

Configure the Time Schedule of Input/Output Point activation.  This is connected to the Time Schedule, 
and the user can modify the signal occurrence of Input/Output Point. 

Basically, controller create signal for all inputs when it receives input signal. Moreover 
controller create output signal when any output signal is received.  

However, input and output signal can be controlled by time schedule. User may be able to 
activate input/output only based on time schedule. 

This function applied for connecting sensor in case of input, for connecting door lock in case 
of output. 

If you connect the sensor in specific input relay, and if it occurred event anytime, day and 
night detecting the situation. 

This case, surplus of event cause slowing the processing, which cause that the useless 
information would be stored. 

If you set the time schedule for input point connected sensor, such as 08:00~18:00 which will 
not operate during set time. Sensor works during 18:01~07:59. Except above time, the event 
will not occurred, even the sensor works. 

In case of output, if you connect the door lock to certain output, depending on the output 
status, which keep the continuously lock or release. 
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During the working hours (such as day time), you can set the door to be open, after working 
hours, the door automatically locks.  If the registered card is presented after the working 
hours, the door opens once. 

In case output, within the time schedule, keep unlock, except this time, keep the lock the door. 

 Start 

Select Set Up->Input/Output Definition List or press shortcut key Ctrl+E. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to edit and delete the existing data information. 

 

1) Select Loop No. and Controller No. as appropriate. 

2) Select Find to make an inquiry.  If inquired result is available it will display the results.  

If find has no specific parameters, it will display the entire information 

 Modify 

Select the Input Point of the controller to be modified.  Selected data is highlighted. 
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1) Select Modify button. 

  

2) Selecting the DropDownCombo of corresponding Input Point will display the contents setup in 
Time Schedule.  Select the time schedule to apply. 

Default value for Time schedule content means it will not be applied.  However, when an input 
occurs the signal is taken care of at that moment with a result of event. 

3) Select Save button to save. 

4) Select Transmit button to send to controller. 
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When setup is performed for all controller, program, and related data, it is not active until 
transmitted to the controller.  It is possible the transmit function may not work properly. 

5) Select Close button to finish. 

Output Point Time Schedule setup method and Input Point setup method is identical. 

 

Selecting the Drop Down Combo of corresponding Input Point will display the contents setup 
in Time Schedule.  Select the time schedule to apply, then select Save and Transmit button to 
configure. 

You can configure signal handling method of controller, if the Input Point Type connected 
input controllers (Exit, Contact, Sensor, etc..) signal is NO or NC. 
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Selecting the Drop Down Combo of corresponding Input Point will display the NO and NC 
contents.  Select the value to apply then select Save and Transmit button to configure. 

 

Global Antipassback 

Global Antipassback is used to grant access card only when cardholder go in by In-door and go out by 
Out-door in more than one door system. To set Global Antipassback, it is required to set Antipassback 
Enable in Door/Reader Setup.  

 Start 

Click System -> Global Antipassback  menu.  

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available. In 
Access right List, door group information which applied of Global Antipassback. In Door List by 
Group, the information of door information.  
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1) Please input group code, group name according to the condition.  

2) Please click Find button to search. If there is data, searched data will be displayed.  

If there is no condition filled, all the data will be displayed.  

 Add 

Add button is to create new data. To register Global Antipassback, please click Add button and 
input data.  

1)  Please Click Add button. Global Antipassback Definition form will be popped up.  
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2)  Please input Global Antipassback group code and Global Antipassback group name. In the left 
side List, door information which will be applied of Antipassback will be displayed. Please move 
door information using >> button to Selected Global APB Door.  

      To apply Global Antipassback, it required to check Global APB Activity.  

  

3) After all setting has finished, please click Apply button. If Completed button pops up then click 
Close button.  

 

 Modify 

Please select GAPB group which will be modified.  
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1)  Please select Global Antipassback group which will be modified and click Modify button. Global 
Antipassback Definition form will be popped up.  

  

2)    Please select the door which you want to modify and click >> or << button to apply or delete. If 
you don’t want to apply Global Antipassback, please uncheck Global APB Activity.  

3)   Please click Apply button after all modification has finished. Completed message will be popped 
up and click Close button.  

  

 Delete 

This is to delete Global APB information which is already registered.  

1)  Please select Global APB group which will not be used  any more.  
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2)   Please click Delete button.  

3)  If ‘GAPB-Delete the data you select’ message pops up, please click Yes button. Global APB which 
was registered will be deleted. 

 

System Management (Set Date & Time) 

This function resets the controller clock and date in controller.  In general, initial installation of controller 
result in incorrect time data.  Use this function to modify date and time. 

 Start 

Select Set Up->System ->Set Time or press shortcut key Ctrl+G. 
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 Setup 

1. Auto-Transmission Time 

 
 

This function will download the time on computer once a day not to have  

time difference between time on computer and controller. 

When many numbers of controllers are connected, the controller may  
not show the same time with computer and this function will adjust this  
kind of differences. 

 

2. Set Time 

  

1) Change Date, Week, and Time value.  (Displayed default value is time and date of the P.C.) 

2) Select System List to define which controller to transmit to. 

3) Select Transmit button to complete setup. 



 
 
 
 
 
 

STARWATCH DUAL PRO I™ 

84 

System Initialize 

This function is used to setup default status for all stored data or specified part in controller. 

System Initialize is differentiated as System Initialize, Card Data Initialize, Event Data Initialize, and 
Time Schedule Initialize. 

 System Initialize: Setup of all stored data in controller to default value. 

 Card Data Initialize: Setup of stored card data in controller to default value. 

 Event Data Initialize: Setup of stored event data in controller to default value. 

 Time Schedule Initialize: Setup of stored time schedule and work holiday data in controller to 
default value. 

 Start 

Select Set Up-> System ->System Initialize or press shortcut key Ctrl+H. 

 Setup 

  

1) Select Initialize Type. 

2) Select the System List to initialize. 

3) Select Transmit button to initialize. 

You must verify all Initialize Type, before activating it.  Also, use the function with caution, 
because the data will be modified in this function. 
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MasterCard Management 

MasterCard is used to change controller as setup mode. By verifying Mastercard, user can setup all 
functions in controller.  

And Mastercard Management is to transmit Mastercard to controller. Before transmission, card must 
be registered in Cardholder menu.  

 Start 

Select Setup -> System -> Mastercard Management 

 Import Cardholder 

Import Cardholder is used to get the relevant Mastercard information from cardholder 
management list.  

1) In Mastercard Management form, there are ‘Import Cardholder’, ‘Transmit’, ‘Save’ buttons. ‘Import 
Cardholder’ is to import cardholder from Cardholder Management form to set as Mastercard. 
‘Transmit’ button is to send imported data to controller. ‘Save’ button is to save imported card data 
as Mastercard.  

And there are 2 tabs ‘Fingerprint Recognition System List’ and ‘System List’ . ‘Fingerprint 
Recognition System List’ is to send Mastercard to FINGER007, FINGER006. This controllers 
require fingerprint data to set as Mastercard. And ‘System List’ is to send Mastercard to 505R, 
FGR006, ICON100. This controllers don’t require fingerprint data. 

 

2) Click Import Cardholder button and Cardholder Management form will be popped up. Please 
select the card you want to set as Mastercard and click Import button or double click the selected 
line. 
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3) Message like below will be popped up. This is to inform user that selected card will be deleted 
from the Cardholder Management form. If you want to delete the selected card and import the 
data, click ‘Yes’. Otherwise click ‘No’. If you click ‘No’ button, selected card will not be imported to 
the Mastercard Management form. 

 

4) If you click ‘Yes’ Mastercard Management form will be disappeared and card information will be 
imported to the Mastercard Management form like below. 
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5) Before transmission click save button to save imported data as Mastercard and select the 
controller you want to transmit. Click Transmit button to transmit card data to controller. After all 
the process has completed,  ‘Completed’ message will be popped up. 

 

6) As like ‘Fingerprint Recognition System List’, you can import and transmit in ‘System List’ . 

 

Dial-Up Connection 

Dial-Up Connection uses standard phone line to connect to a remote controller for communication.  
External modems are required for each site at remote and host to connect by phone line. 

Also, Dial-Up Connection Management can be used to manage multiple location registration, and 
when needed initiate the location’s remote controller and communication. 

Refer to chapter 8 (STARWATCH DUAL PRO I™ Dial-Up Communication) for detailed information. 

 Start 

Select System->System Management->Dial-Up Connection List or press shortcut key Ctrl+G. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to edit and delete the existing data information. 
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1) Input Find Condition 

2) Select Find to make an inquiry.  If inquired result is available, the following screen appears. 

If find has no specific parameters, it will display the entire information 

 Add 

Add is used to create new data.  Select Add button to add Dial-Up Connection area data through 
input screen. 

  

1) Select Add button and the following screen appear. 
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2) Select Loop No.  You can only select the port that was configured for Dial-Up Connection. 

3) Input Dial-Up Chain Name. 

4) Check mark Out Line if setup, and input Out Line No. 

5) Input Remote Phone No. connected to remote modem. 

6) Check mark Auto Dial-Up Connection if setup, and configure connection and disconnection time. 

When configuring Auto Dial-Up connection, you must verify the connection and disconnection 
time does not overlap in multiple locations.  This will cause abnormal operation. 

7) Select Save button to save input data.  Select Close button to finish. 

In Dial-Up Connection, connection failure can be frequent depending on the phone line and 
modem status.  This is a special characteristic occurrence, and it is possible for 2-3 
reattempts before normal connection is established. 

 

 Dial 

Dial can be used in Dial-Up Connection List, Add, and Modify screen, but we recommend use as 
possible in the Dial-Up Connection List screen. 
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1) Use Find to locate connection or select from Dial categories to connect.  Selected location is 
highlighted. 

2) Select Dial for connection attempt. 

 Hang Up 

 

1) Select current established connect location. 

2) Select Hang Up to disconnect. 

 Modify 

Modify is used to change existing data.  Find data to modify or to change registered content. 
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1) Select data to Modify, then select Modify button. 

 

2) Select Save button after data is modified to save. 

3) Select Close button to finish. 

 Delete 

Delete is used to delete existing   data.  Find data to delete or to delete registered content data. 

Selected data is displayed as below figure in highlighted bar. 
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1) Select Delete button.  The screen below will appear.  Select Yes button to delete or No button to 
cancel. 

 

Map Definition 

This sets the map of each floor using the area/floor as basis.  Door and sensor location can be 
designated on the map.  This lets the user see which location the event occurred by the setup of the 
map to be displayed automatically, when the event occurs at the time. 

 Start 

Select Set Up->Map Definition or press shortcut key Ctrl+R. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to edit and delete the existing data information. 
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1) Input or select Find condition. 

2) Select Find to make an inquiry.  If inquired result is available, the following screen appears. 

If find has no specific parameters, it will display the entire information 

 Add 

Add is used to create new data.  Select Add to input data of new map through the input screen. 

 

1) Select Add and the screen below appear. 
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2) Input Map Code and Map Name. 

3) Select Area and Floor for the location to be implemented. 

4) Select Map File.  User can select file as bmp, jpg, wmf and can check the image file as shown 
above before applying. 

5) Select Save button to save data. 

 Map Item Setup 

This function configures access door and sensor for the setup area/floor location.  This sets the 
sensor and access door location to be displayed on the real map to check status of sensor. 

1) Select Map Item button. 
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2) The following screen displays. 

 

The display of map setup is identical to real map in size.  Also, as shown above, the current map’s 
corresponding access door and sensor is displayed as an icon. 

The door and sensor icon of corresponding map area data is automatically displayed.  For a 
door, the setup of Reader/Door data during registration is used.  It uses this data as basis to 
display the number of icons automatically on the corresponding map. 
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Sensor uses identical method to display the icons automatically, by setup of the Input/Output 
Point setup. 

3) Use the mouse to select and drag the door and sensor icon to the desired location. (Hold down 
the mouse button to drag, and release the button to set) 

 

Locate the door and sensor icon with the mouse pointer, and the door and sensor name is 
displayed by tool tip.  At the bottom displays the controller connected to the current door and 
sensor, along with data including names and location. 

Use the above data as basis to control the location of doors and sensors. 

4) If re-location of the icon is completed, then select (X) on the right hand corner. 

5) If location was changed, it will display the following message.  Select Yes button to save. 

 

 Modify 

Modify is used to change existing data.  Find data to modify or to change registered content. 

Selected data is displayed as below figure in highlighted bar. 
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1) Select Modify button and the following screen appear.  This screen is identical to register screen.  
Map Code cannot be modified in this mode. 

 

2) Modify Data. 

3) Select Save button to save.  

4) Select Map Item button to setup location.  Once completed, select Close button to finish. 

5) Select Close button to finish. 
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 Delete 

Delete is used to delete existing data.  Find data to delete or to delete registered content data. 

Selected data is displayed as below figure in highlighted bar. 

  

1) Select Delete button.  The screen below will appear.  Select Yes button to delete or No button to 
cancel. 
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Database 

Database menu contains functions for Company, Department, Title, Area Data, User Management, 
Database Management, and Access Control Option.  It is recommended to input all data if possible, 
because they are used as basis in initial input data for Access Control and Time & Attendance. 

Area/Floor Definition 

Area/Floor configuration is used for default data creation to distinguish access door, reader, and 
sensors by installed locations.  Multiple buildings can be designated by area, and the floors correlating 
to the area can be distinguished. 

 Start 

Click Database->Area/Floor definition or press Ctrl+P on keyboard. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to edit and delete the existing data information. 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
1) Input or select Find condition. 

2) Click Find to make an inquiry.  If inquired result is available, the following screen appears. 

If find has no specific parameters, it will display the entire information 
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 Add 

Add is used to create fresh data.  Click Add to input data of area and floor through the input 
screen. 

 

1) Click Add and the screen below appear. 

  

2) Input area code.  If already registered code is used, it will not register, but only a fresh area code.  
Do not overlap Area Code. 

3) Input area name. 
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Select floor then click Add button.  It will show up in Floor List window.  Repeat this procedure to 
add additional floors. 

4) If all the floors are added to the area, click Save button to save. 

5) Click Close to finish. 

 Modify 

Modify is used to change existing data inputted.  Find data to modify or to change registered 
content. 

Selected data is displayed as below figure in highlighted blue bar.  Selecting the Area will display 
the corresponding floors on the right hand side content. 

  

1) Click Modify button and the following screen appears.  This screen is identical to register screen.  
Area Code cannot be modified in this mode. 
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2) Modify Area Name and data by Delete or Add function. 

3) Click Save button to save data, then click Close button to finish. 

 Delete 

Delete is used to delete existing inputted data.  Find data to delete or to delete registered content 
data. 

Selected data is displayed as below figure in highlighted blue bar. 

Deleting the Area data will also delete the corresponding floor data. 
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1) Click Delete button.  The screen below will appear.  Click Yes button to delete or No button to 
cancel. 

 
 
 
 
 
 
 
 

Company Definition 

Input company name using the system. 

 Start 

Select Database->Company Definition or press shortcut key Ctrl+L. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to edit and delete the existing data information. 
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1) Input Company Code and Company Name as appropriate. 

2) Select Find to make an inquiry.  If inquired result is available, the following screen appears.  

If find has no specific parameters, it will display the entire information 

 Add 

Add is used to create new data.  Select Add button to add a data through input screen. 

 

1) Select Add button and the following screen appear. 
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2) Input Company Code.  If using a registered code, it will not register and a code being used 
message is displayed.  Do not overlap the Company Code in use. 

3) Input Company Name. 

4) Select Save button to save and select Close button to finish. 

 Modify 

Modify is used to change existing data.  Find data to modify or to change registered content. 

Selected data is displayed as below figure in highlighted bar. 

  

1) Select Modify button and the following screen appear.  This screen is identical to register screen.  
Company Code cannot be modified in this mode. 

 

2) Modify data. 

3) Select Save button to save data then select Close button to finish. 
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 Delete 

Delete is used to delete existing data.  Find data to delete or to delete registered content data. 

Selected data is displayed as below figure in highlighted bar. 

  

1) Select Delete button.  The screen below will appear.  Select Yes button to delete or No button to 
cancel. 

 

The Department, Title, and Access Type can be setup as identical process in Company 
registration.  Detailed instruction is omitted. 

Department Definition 

Input Department name using the system. 

 Start 

Select Database->Department Definition or press shortcut key Ctrl+M 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to edit and delete the existing data information. 
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3) Select Company and input Department Code and Department Name as appropriate. 

4) Select Find to make an inquiry.  If inquired result is available, the following screen appears.  

If find has no specific parameters, it will display the entire information 

 Add 

Add is used to create new data.  Select Add button to add a data through input screen. 

 

5) Select Add button and the following screen appear. 
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6) Select Company and Input Department Code.  If using a registered cod e, it will not register and a 
code being used message is displayed.  Do not overlap the Department Code in use. 

7) Input Department Name. 

8) Select Save button to save and select Close button to finish. 

 Modify 

Modify is used to change existing data.  Find data to modify or to change registered content. 

Selected data is displayed as below figure in highlighted bar. 

  

4) Select Modify button and the following screen appear.  This screen is identical to register screen.  
Company and Department Code cannot be modified in this mode. 

 

5) Modify data. 
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6) Select Save button to save data then select Close button to finish. 

 Delete 

Delete is used to delete existing data.  Find data to delete or to delete registered content data. 

Selected data is displayed as below figure in highlighted bar. 

  

2) Select Delete button.  The screen below will appear.  Select Yes button to delete or No button to 
cancel. 

 

Title Definition 

Input Title name using the system. 

 Start 

Select Database->Title List or press shortcut key Ctrl+N 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to edit and delete the existing data information. 
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5) Input Title Code and Title Name as appropriate. 

6) Select Find to make an inquiry.  If inquired result is available, the following screen appears.  

If find has no specific parameters, it will display the entire information 

 Add 

Add is used to create new data.  Select Add button to add a data through input screen. 

 

9) Select Add button and the following screen appear. 
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10) Select Company and Input Title Code.  If using a registered code, it will not register and a code 
being used message is displayed.  Do not overlap the Title Code in use. 

11) Input Title Name. 

12) Select Save button to save and select Close button to finish. 

 Modify 

Modify is used to change existing data.  Find data to modify or to change registered content. 

Selected data is displayed as below figure in highlighted bar. 

  

7) Select Modify button and the following screen appear.  This screen is identical to register screen.  
Company and Title Code cannot be modified in this mode. 
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8) Modify data. 

9) Select Save button to save data then select Close button to finish. 

 Delete 

Delete is used to delete existing data.  Find data to delete or to delete registered content data. 

Selected data is displayed as below figure in highlighted bar. 

  

3) Select Delete button.  The screen below will appear.  Select Yes button to delete or No button to 
cancel. 

 

Access Type Definition 

Input Access Type using the system. 

 Start 

Select Database->Access Type Definition or press shortcut key Ctrl+O. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to edit and delete the existing data information. 
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7) Select Company and input Type Code and Title Name as appropriate. 

8) Select Find to make an inquiry.  If inquired result is available, the following screen appears.  

If find has no specific parameters, it will display the entire information 

 Add 

Add is used to create new data.  Select Add button to add a data through input screen. 

 

13) Select Add button and the following screen appear. 



 
 
 
 
 
 

STARWATCH DUAL PRO I™ 

114 

 

14) Select Company and Input Type Code.  If using a registered code, it will not register and a code 
being used message is displayed.  Do not overlap the Type Code in use. 

15) Input Title Name. 

16) Select Save button to save and select Close button to finish. 

 Modify 

Modify is used to change existing data.  Find data to modify or to change registered content. 

Selected data is displayed as below figure in highlighted bar. 

  

10) Select Modify button and the following screen appear.  This screen is identical to register screen.  
Company and Type Code cannot be modified in this mode. 

 

11) Modify data. 
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12) Select Save button to save data then select Close button to finish. 

 Delete 

Delete is used to delete existing data.  Find data to delete or to delete registered content data. 

Selected data is displayed as below figure in highlighted bar. 

  

4) Select Delete button.  The screen below will appear.  Select Yes button to delete or No button to 
cancel. 

 

User Management 

This function registers the user to operate STARWATCH DUAL PRO I™.  For default value (admin) is 
registered in the program, and you can register additional user or change authority of existing user. 

 Start 

Select Database->User Management or press shortcut key Ctrl+S. 

 Add 

Add is used to create new data.  Select Add button to add new user through input screen. 
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1) Select Add button and the following screen appear. 

 

2) Input User ID.  User ID cannot be overlapped. 

3) Input User Name and User Password. 

4) Check mark Administrator option or not. 

Administrator option gives authority to Add, Modify, and Delete user.  Only the User who has 
this authority can perform these functions.  User with no authority can use allowed functions, 
but not the above functions. 

5) Select Save button to save then Close to finish. 

 Modify 

Modify is used to change existing data.  Select data to Modify.  

Selected data is displayed as below figure in highlighted bar.  
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1) Select Modify to see the above screen.  The Modify screen is equal to registration screen.  User 
ID cannot be changed. 

  

2) Modify data to change. 

3) Select Save button to save data. 

4) Select Close button to finish. 

 Delete 

Delete is used to delete existing data.  Find data to delete or to delete registered content data.  
Selected data is displayed as below figure in highlighted bar. 
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1) Select Delete button.  The screen below will appear.  Select Yes button to delete or No button to 
cancel. 

 

 User Permission 

This function sets the permission of use for each function type.  User can only use functions with 
permission designation, and this function can setup entire function or parts of it. 

 

User Permission is categorized in menu type as shown above.  User can setup use permission 
under each sub menu category under main category. 

1) For use permission, check mark the item and if canceling use authority, uncheck mark item. 

 All Permission Grant: Setup all authority at once. 

 All Permission Cancel: Setup all authority as cancelled. 

 Select All:  Setup use authority of corresponding menu at once. 

 Clear All: Cancel use authority of corresponding menu at once. 

2) Once completed, select Save button to save. 

3) Select Close button to finish. 
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Database Management 

Database Management describes the backup, restore, and database compact function of data using 
the STARWATCH DUAL PRO I™.  Also, through backup, restore, and history, it provides the backup 
week cycle message from the last backup date.  This is setup by the user at alert interval. 

Refer to chapter 9 STARWATCH DUAL PRO I™ Maintenance and Management for detailed 
information.  

Option 

Option lets the user activate additional functions on user setup.  User can designate event type 
database store and display of data, and setup a separate sound file for playing out the sound during 
an event occurrence. 

Also, when the event occurs, the setup of designated email recipient will send out the event occur 
status automatically.  

Also, sets the option of map display when some event occurs with connection to the map display. 

 Start 

Select Database->Option or press shortcut key Ctrl+U. 

 Event Transaction Option 

This sets the whether or not to save Event Type database and to display event in Event Status 
screen. 
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1) Checkmark the items for event occur display on monitor.  If display is not necessary, cancel check 
mark. 

2) Check mark the items for event occur database save.  If save is not necessary, cancel the check 
mark. 

3) Select Save button to save then select Close button to finish. 

4) Select Close button to finish. 

 Sound Option 

This designates sound file by event type.  Once implemented, when an event occurs the setup 
sound file plays through a speaker with sound card in PC alerting the event status. 
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1) Check mark the items for sound play during an event occurrence.  If sound play is not necessary, 
cancel check mark. 

2) Select Search button on bottom to find sound file.  Selecting the file displays in Select Sound 
(Alarm) window.  Right hand side window displays the matched sound file. 

Sound file can only be selected as wav. File.  To play the sound, a PC with sound card and 
speaker is required.  

3) Select Save button to save. 

4) Select Close button to finish.  

 Email Option 

This function sends out email up to 3 recipients when a specific event occurs if setup.  Email 
contains date of event, time, event location, and type of event as data. 

To use this option, the operating PC must be connected to a network.  

This can be used with onsite mail server at company, and requires POP3 support to use this 
option.  If POP3 is not supported, this option will not work.  
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1) Checkmark the items for e-mail transaction during an event occurrence.  If transaction is not 
necessary, cancel check mark. 

2) Input Mail Server (SMTP) address. 

3) Input Name and Email Address of up to 3 recipients. 

4) Select Save button to save. 

5) Select Close button to finish. 

 View Map Option 

If a map is setup, it will automatically display when a specified event occurs.  Here the event type 
map display presence is setup.  View Map Option needs to be setup to display map automatically. 
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1) Check mark the items for map display during an event occurrence.  If map display is not 
necessary, cancel check mark. 

2) Select Save button to save. 

3) Select Close button to finish. 
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Access Control 

Access Control Management contains functions required for User Management.  A Detail regarding 
access is setup and user registered.  Setup data is transmitted to controller. 

Holiday Definition 

This function connects to Time Schedule to apply.  Time Schedule can be setup from Mon-Sun with 
designated time for each day.   

For this function, the holiday data needs to be initially setup.  Holiday Definition is to apply holiday to 
Time Schedule and transmit to controller to setup. 

 Start 

Select Access Control ->Holiday Definition or press shortcut key F2. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to modify and delete the existing data information. 

  

1) Input Holiday Code and Holiday Name as appropriate. 

2) Select Find to make an inquiry.  If inquired result is available, the following screen appears. 
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 Add 

Add is used to create new data.  Select Add button to add holiday through input screen. 

 

1) The following screen appears after selecting Add. 

  

2) Select Holiday Code.  (Holiday Code can be used from 01-10 giving 10 codes for use) 

3) Input Holiday Name to be saved. 

4) Select the corresponding date, and double click the date on the calendar or select >> button. 
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5) If an exception is needed on a selected Holiday, select the corresponding date and double click or 
select << button. 

 

6) Select Save button to save data, and select Close button to finish. 

 Modify 

Modify is used to change existing data.  Find data to modify or to change registered category. 

Selected data is displayed as below figure in highlighted bar. 

  

1) Select Modify to see the following screen.  The Modify screen is equal to registration screen.  
Holiday Code cannot be changed. 
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2) Modify the items to be changed. 

3) Select Save button to save data, and select Close button to finish. 

 Delete 

Delete is used to delete existing data.  Find data to delete or to delete registered content list data. 

Selected data is displayed as below figure in highlighted bar. 
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1) Select Delete button.  The screen below will appear.  Select Yes button to delete or No button to 
cancel. 

 

 Transmit 

This function is used to send the setup functions to the controller for activation.  Use Find to 
search for data transmit or select the data from the registered reader categories to send. 

Selected data is displayed as below figure in highlighted bar. 

  

1) Select Transmit button.  This will send the selected data to the corresponding Controller No for 
application. 

If an error does occur, detailed explanation is displayed in a message box. 

In this case, retransmit the data, but if the error continues, check the communication and 
controller for problems. 
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Time Zone Definition 

This function sets the access time as 24 hours or divided into 5 time sections within 24 hours.  These 
data is setup in Time Schedule as per day. 

 Start 

Select Access Control->TimeSchedule Definition->Time Zone Definition List or press shortcut key 
F3. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to modify and delete the existing data information.  

 

1) Input Time Code and Time Code Name as appropriate. 

2) Select Find to make an inquiry.  If inquired result is available, the following screen appears. 

 Add 

Add is used to create new data.  Select Add button to add work holiday through input screen. 
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1) The following screen appears after selecting Add. 

 

2) Input Time Code. 

3) Input Time Code Name. 

4) Setup the time From/To for Time 1, Time 2, Time 3, Time 4, Time 5. 

For example, the screen below shows (00:00-01:59 No Access, 02:00-05:00 Access Grant, 
05:01-08:59 No Access, 09:00-12:00 Access Granted, …) 
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5) Select Save button to save and Close button to finish. 

The section of time schedule is set up within 24 hours of a day. 

Namely, if you intend to set up for 24 hours without division of 24 hours of a day, you have to 
input 0000-2400 in 1st section. The rest section is set up as 0000-0000 automatically. 

If you want to divide and use 24 hours of a day, it is possible to divide to maximum of 5 
sections. To divide hours is mainly used to control the access time to work together with time 
schedule of input/output. 

Namely if you admit to access door at AM and don’t admit at PM, it is applied in this case. 
The division of time is needed, in case of application of Lock or Unlock of access door. 

 Modify 

Modify is used to change existing data.  Find data to modify or to change registered content 
category. 

Selected data is displayed as below figure in highlighted bar. 
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1) Select Modify to see the following screen.  The Time Code List screen is equal to registration 
screen.  Time Code cannot be changed. 

 

2) Modify the items to change. 

3) Select Save button to save data, and select Close button to finish. 

 Delete 

Delete is used to delete existing data.  Find data to delete or to delete registered content list data. 

Selected data is displayed as below figure in highlighted bar. 

 

1) Select Delete button.  The screen below will appear.  Select Yes button to delete or No button to 
cancel. 
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Timeschedule Definition 

This function uses Time Zone data to setup time schedule for each day.  It is applied to the user to 
control access time, and is connected to the Input/Output Point time schedule. 

Time Schedule can create up to 10 codes, and time schedule within the codes are sent to the 
controller for activation.  Setup the time schedule needed. 

 Start 

Select Access Control ->Time Schedule List or press shortcut key F4. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to modify and delete the existing data information. 

  

1) Input Timeschedule Code and Timeschedule Name as appropriate. 

2) Select Find to make an inquiry.  If inquired result is available, the following screen appears. 

 Add 

Add is used to create new data.  Select Add button to add Timeschedule through input screen. 
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1) The following screen appears after selecting Add. 

  

2) Select Timeschedule Code.  It will display only the registered codes.  Use one of the 10 Codes. 

3) Input Timeschedule Name. 

4) Select Timeschedule Code to apply to each day. 

5) Select Holiday Code to apply holiday, and if not used select Not Use.  If Holiday Code was 
selected, Timeschedule Code for holiday needs to be selected. 

Selecting the Timeschedule Code will display at the bottom screen location, current selected time 
range in hour format. 
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6) Select Save button to save. 

7) Select Transmit button.  This will send the selected data to the corresponding Controller No for 
application. 

8) Select Close button to finish. 

 Modify 

Modify is used to change existing data.  Find data to modify or to change registered content 
category. 

Selected data is displayed as below figure in highlighted bar. 

 

1) Select Modify to see the following screen.  The Timeschedule List screen is equal to registration 
screen.  Timeschedule Code cannot be changed. 
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2) Modify the items to be changed. 

3) Select Save button to save data.  

4) Select Transmit button to send the selected data to the corresponding Controller No for 
application. 

 Delete 

Delete is used to delete existing data.  Find data to delete or to delete registered content list data. 
Selected data is displayed as below figure in highlighted bar. 

  

1) Select Delete button.  The screen below will appear.  Select Yes button to delete or No button to 
cancel. 
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 Transmit 

This function is used to send the setup functions to the controller for activation.  Use Find to 
search for data transmit or select the data from the registered reader categories to send. 

Selected data is displayed as below figure in highlighted bar. 

  

1) Select Transmit button.  This will send the selected data to the corresponding Timeschedule Code 
for application. 

If an error does occur, detailed explanation is displayed in a message box. 

In this case, retransmit the data, but if the error continues, check the communication and 
controller for problems. 

Access Group Definition 

When multiple units of controller are operated, by using each access door connected to the system, 
you can create Access Group to register user in a group type to control access area as a whole or 
control as is. 

 Start 

Select Access Control ->Access Right List or press shortcut key F5. 

 Find 
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Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to modify and delete the existing data information.  

  

1) Input Group Code and Group Name as appropriate. 

2) Select Find to make an inquiry.  If inquired result is available, the following screen appears. 

 Add 

Add is used to create new data.  Select Add button to add Access Group through input screen. 

 

1) The following screen appears after selecting Add. 
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2) Input Access Group Code.  Do not overlap this code. 

3) Input Access Group Name. 

4) Select Timeschedule to apply. 

5) Double click the Access Door from Available Access Door List, or select >> button to register and 
apply corresponding Timeschedule and apply corresponding Reader. 

The Timeschedule and Access Door work as a team to setup Access Group.  This means the 
access door and Timeschedule setup correspond to use the configured access door(s). 

6) Repeat the above method to register additional Access Group. 

Cancel Access Door by double clicking on selected door or select << button. 
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7) Select Save button to save data, and select Close button to finish. 

 Modify 

Modify is used to change existing data.  Find data to modify or to change registered group 
category. 

Selected data is displayed as below figure in highlighted bar. 

  

1) Select Modify to see the following screen.  The Access Group is equal to registration screen.  
Therefore, the Access Group Code cannot be changed. 
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2) Modify the items that need changing. 

3) Select Save button to save the modified information.  Select Close button to finish. 

 Delete 

Delete is used to delete existing data.  Find data to delete or to delete registered content data. 

Selected data is displayed as below figure in highlighted bar. 

  

1) Select Delete button.  The screen below will appear.  Select Yes button to delete or No button to 
cancel. 
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Card Holder Management 

This function registers user ID card.  Also basic personal data is to approve ID card, and related data 
is displayed and used as Find/Output data.  At the time of registration, Access Group and 
Time/Attendance is setup also. 

 Start 

Select Access Control ->Card Holder Management or press shortcut key F6. 

 Card Holder Screen 

The Card Holder Screen has two modes. First screen is a normal mode. Second screen is a 
fingerprint management mode. 

The normal mode is used with STAR (SR) 505R, STAR ICON100 (SR).  The fingerprint 
management mode is used with STAR FINGER007 (SR). 

 

- Card Holder List Screen : Normal Mode 

(Using a (SR)STAR 505R , STAR ICON100(SR)) 
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- Card Holder List Screen : Fingerprint Recognize Mode 

  (Using FINGER007(SR)) 

 

- Card Holder Management Screen : Normal Mode 

 

- Card Holder Management Screen : Fingerprint Recognize Mode 
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 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to edit and delete the existing data information. 

 

1) Select Find button. The screen will appear. 

2) Input Company, Employee No, Name, and Card No as appropriate. Select Sort By and Sort Order. 

3) Select Find to make an inquiry.  If inquired result is available, the screen appears. 

 Add 
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Add is used to create new data.  Select Add button to add user data through input screen. 

  

1) The following screen appears after selecting Add. If a Finger007 is installed, fingerprint 
management tab appears. 

 

2) Input Employee No, Name, and Card No or Mifare Card No. This input is a requirement.  Card No, 
Mifare No. is the ID number, and depending on card type, the digits range from 8-10. 

Employee No. must not overlap.  It is used as a key to identify user. 
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Input 4 digits Password if using card+pw to authenticate.  If you do not input a password, the 
default value of 0000 is setup. 

3) Input user’s detailed information as basic data. 

4) Input Issuing and Expire date.  Putting a check mark on Auto Delete on Expired Date will delete 
the corresponding ID number. 

This software has the function of auto-deletion of ID number at the expiration date by 
transferring deletion order through communication after checking expiration date in S/W. It is 
processed only when the program operates under normal condition.  

But even though the program was ended, when it is operated again, registered persons who 
expiry date is set at former date than the date of PC and auto-deletion is checked are deleted 
automatically. 

In case that communication error is occurred, it may not be processed automatically, for that 
this function is done through the communication of program. 

5) Select Access Right tab. 

This is used to limit the access area on the user by selecting placed Access Group or selecting 
Individual Access Door to limit the access area. 

 

If you limit the access through defined access group, choose defined access group and 
choose access group at the lower part. Then access door list included in access group is 
indicated at the bottom. 
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The setting of Individual access doors can be used at the access group setting mode in case 
the proper access group does not exist,  or in case that you want to make and set the access 
group directly. In this case select setting of individual access doors and the time schedule in 
the same method with access group setting, then, double click the door to work with this time 
schedule. 

6) Select Time & Attendance tab for Time & Attendance. 

This is used to apply Time & Attendance by input of corresponding data.  Refer to chapter 6 
STARWATCH DUAL PRO I™ Time Attendance for detailed information. 

 

Input Date Employed.  Input Retirement Date if that is the case.  For a user who is retired, cancel 
the time/attendance by removing check mark in Apply Time & Attendance.  This option 
determines whether or not data is created. 

If selecting Apply Time & Attendance, user needs to select Work Time and Work Holiday. 

Work Time is applied per individual by using the Work Code setup. Work Holiday is applied per 
individual to calculate attendance on a holiday work. 

Work Time and Work Holiday needs to be setup initially through work in registration and work 
holiday registration. 

Select Save button to save data. 

Select Transmit button.  This will send the selected data to the system for application. 

Refer to chapter 6 STARWATCH DUAL PRO I™ Time and Attendance regarding setup for Work 
Time and Work Holiday. 

7) If system uses a FINGER007 (SR), select the fingerprint management tab.  
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This is used to apply a fingerprint data management.  

 

Select a fingerprint use/not use mode.  

If selecting applies a fingerprint use mode, user needs to upload a fingerprint data from 
FINGER007 system that stores a fingerprint data. 

Select a fingerprint system that has a card holder’s fingerprint data. 

Select ‘Receive a Fingerprint Data’ button to upload data. 

When it is transmitted lowing the setting of access group. So if a lot of access areas exited, it 
might take some time for transportation of data. And in case of communication error, 
transmission error or delay of time can happen. 

And when the data is being transmitted, transmission status is indicated in the middle of 
screen. 

This function will be operated only for normal communication status so that if the 
communication is lost, this function will not operate properly.  

 Modify 

Modify is used to change existing data. Or if system uses a FINGER007 (SR), can uses an 
uploading fingerprint.  Find data to modify or to change registered content list. 

Selected data is displayed as below figure in highlighted bar. 
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1) Select Modify to see the following screen.  The screen is equal to registration screen.  Therefore, 
the Employee No. cannot be changed. 

 

2) Modify items to change.  Modify Detailed Information, Access Right, and Time & Attendance.  

3) Select Save button to save data. 

4) If system uses a FINGER007 (SR), select the fingerprint management tab.  

This is used to apply a fingerprint data management.  
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Select a fingerprint use/not use mode.  

If selecting applies a fingerprint use mode, user needs to upload a fingerprint data from 
FINGER007 system that stores a fingerprint data. 

Select a fingerprint system that has a cardholder’s fingerprint data. 

Select ‘Receive a Fingerprint Data’ button to upload data. 

 

5) Select Close button to finish. 

If card no. or access group data was modified, you need to retransmit the data. 

 Delete 

Delete is used to delete existing data.  Find data to delete or to delete registered content list data. 

Selected data is displayed as below figure in highlighted bar. 
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1) Select Delete button.  The screen below will appear.  Select Yes button to delete or No button to 
cancel. 

 

2) Selecting Yes button will delete all ID cards in controller.  Once completed, it will ask the user if the 
current data is going to be deleted from database in a message box. 

Selecting Yes will delete from database, and registered into Delete Management to be restored 
later. 

 

3) Select Close button to finish. 

 Individual Transmit 

This function transmits the selected data to the controller, and activates the setup functions.  User 
is selected from the corresponding access group to be sent to the registered access door. 
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 Batch Transmit 

This transmits the entire data through Find in means of Find Condition to the controller.  If find has 
no specific parameters, it will display the entire information.  In this case, selecting Batch Transmit 
will send entire registered data, but if specific parameter is used to find, it sends the found result 
completely. 
 

 
 Upload Fingerprint data 

This function uploads a selected card holder’s fingerprint data from the fingerprint controller. 
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 Batch upload fingerprint data 

This function uploads all card holders’ fingerprint data that is stored in fingerprint controller from 
fingerprint controller. 
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Deleted Card Management  

This function lets the user manage the deleted data from User Contents.  If later on the deleted user is 
to be reinstated, this function recovers the data to register user without having to input the information 
all over again. 

 Start 

Select Access Control Management->Deleted Card Management or press shortcut key F7. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.   

 

1) Input Company, Employee No, Name, and Card No as appropriate. 

2) Select Sort By and Sort Order. 

3) Select Find to make an inquiry.  If inquired result is available, the screen appears. 

 Recover 

This is used to recover deleted user data.  Use Find to locate or registered deleted user content to 
select data for recovery. 

Selected data is displayed as below figure in highlighted bar. 
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1) Select data to recover from Find or Contents. 

2) Select Recover button to begin. 

 Delete 

Delete is used to delete existing data.  Find data to delete or to delete registered content list data. 

 

1) Select Delete button.  The screen below will appear.  Select Yes button to delete or No button to 
cancel. 
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Visitor Management  

This function manages visitor access by means of temporary visit registration.  The visitor is 

issued a card with setup of access area, and expire the access with input of Expire date 

automatically. 

 Start 

Select Access Control Management->Visitor Management or press shortcut key F8. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to edit and delete the existing data information.  

  

1) Input Company, Name, Telephone No, and Card No as appropriate. 

2) Select Sort By and Sort Order. 

3) Select Find to make an inquiry.  If inquired result is available, the screen appears. 

 

 Add 

Add is used to create new data.  Select Add button to add visitor information through input screen. 
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1) The following screen appears after selecting Add. 

 

2) Input Company, Name, and Card No.  This input is a requirement and must be done. 

3) Input visitor information. 

4) Setup Issuing Date and Expire Date.  Expire Date activates the automatic deletion of visitor ID.  
This means if the Expire Date matches the current PC time, the ID is automatically deleted from 
the controller through communication. 
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The function of auto-deletion of ID number at the expiration date is transferred deletion order 
through communication after check expiration date in S/W. It is processed only when the 
program is being operated normally.  

This function will be operated only for normal communication status so if the communication 
is lost, this function will not operate properly. 

5) Setup visitor access area.  Select from the Access Group already in place.  This function needs to 
be registered initially. 

6) Select Save button to save. 

7) Select Transmit to register the ID to controller.  

8) If system uses a FINGER007 (SR), select the fingerprint management tab.  

This is used to apply a fingerprint data management.  

Select a fingerprint use/not use mode.  

If selecting applies a fingerprint use mode, user needs to upload a fingerprint data from 
FINGER007 system that stores a fingerprint data. 

Select a fingerprint system that has a visitor’s fingerprint data. 

Select ‘Receive a Fingerprint Data’ button to upload data. 

 

9) Select Close button to finish. 

 

 Modify 
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Modify is used to change existing data.  Find data to modify or to change registered content 
category. 

Selected data is displayed as below figure in highlighted bar. 

  

1) Select Modify to see the following screen.  The Visitor Management Modify is equal to registration 
screen.  Therefore, Company and Name cannot be changed. 

 

2) Modify data.  You must transmit, if Card No and Access Group is changed. 

3) If system uses a FINGER007 (SR), select the fingerprint management tab.  

This is used to apply a fingerprint data management.  
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Select a fingerprint use/not use mode.  

If selecting applies a Fingerprint Use mode, user needs to upload a fingerprint data from 
FINGER007 system that stores a fingerprint data. 

Select a fingerprint system that has a visitor’s fingerprint data. 

Select ‘Receive a Fingerprint Data’ button to upload data. 

 

4) Select Save and Transmit button. 

5) Select Close button to finish. 

 Delete 

Delete is used to delete existing   data.  Find data to delete or to delete registered content data. 
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1) Select Delete button.  The screen below will appear.  Select Yes button to delete or No button to 
cancel. 

 

 Transmit 

This function is used to send the setup functions to the controller for activation.  Use Find to 
search for data transmit or select the data from the registered reader categories to send. 
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1) Select from Visitor List. 

2) Select Transmit.  Select Close to finish. 

 

 

 

 

 

 

 

 

 

 

 

 



 
 
 
 
 
 

STARWATCH DUAL PRO I™ 

163 

View 

Access Door Status/Control 

This function lets the user monitor access door status in real time.  The icon status changes displaying 
in real time (Door Open, Door Closed, Lock, and Unlock) 

Also, the user can control Lock, Unlock of access door by location of (entire, area type, floor type, 
individual type door) 

 Start 

Select View->Door Status/Control or press shortcut key Ctrl+F1. 

 Control 

This is used to control door of (entire, area type, floor type, individual type door) 
 

 Lock (Entire): Entire doors are locked. 
 

 Unlock (Entire): Entire doors are unlocked. 
 

 Lock (Area): Selected area doors are all locked. 
 

 Unlock (Area): Selected area doors are all unlocked. 
 

 Lock (Floor): Selected Floor doors are all locked. 
 

 Unlock (Floor): Selected Floor doors are all unlocked. 
 

 

Access door 
control buttons 

The status of all access doors is 
showed as text. Able to control 
each door, once you click right 
button of mouse at access door.  

Access doors included appropriate area or 
floor as following the condition of area and/or 
floor are indicated.  The change of icon will 
display as the status of doors changes. 
Able to control each door, once you click right 
button of mouse at access door.  
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 Lock: Selected door is locked. 
 

 Unlock: Selected door is unlocked. 
 

 3 sec Unlock: Selected door is unlocked for 3 sec. 
 

 5 sec Unlock: Selected door is unlocked for 5 sec. 
 

 10 sec Unlock: Selected door is unlocked for 10 sec. 
 

 

 

 

Transaction Status 

This function displays normal and alarm events when an event occurs.  It lets the user to check the 
real time event status. 

 Start 

Select View->Transaction Status or press shortcut key Ctrl+F2. 

 Event Status 

This displays normal access events. 
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 Alarm Status 

This displays various alarm events.  It shows user access denied event, timeschedule error, and 
other input/output events. 

Also, in the event of an alarm, there is an Admin acknowledgement function.  User needs to 
acknowledge alarm status.  If the alarm event was not checked, it will load into the alarm status 
when program is rebooted. 

The number of alarm status loaded into the program is 3000 listings standard.  If the user 
does not check the alarm status the alarm status will roll from the beginning and will not 
display again. 
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 ACK. All:  Acknowledge all alarm events currently displayed. 
 

 ACK: Acknowledge alarm event selected with a mouse. 
 

 Alarm Details: Acknowledge alarm event selected with a mouse can input details with 
Operator Comments.  Once the alarm details are completed, select ACK button to 
acknowledge. 

 

 
 

Alarm Status is displayed in various colors depending on alarm event type.  Also, when the 
Admin acknowledges an alarm event, the event is displayed in black to check whether or not 
the alarm event was acknowledged. 
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Report 

Card Holder List Report 

The registered user status in Card Holder Management can be outputted. 

 Start 

Select Report->Card Holder List or press shortcut key Ctrl+F4. 

 Print 

This function uses registered Card Holder data as basis to print Card Holder contents in 
agreement to Find Condition. 

 

1) Select Report Type. 

Door Access Reports simply print employee’s number, name, company, department, title, 
and access group. 

Door Access Detail Reports print user’s personal information and their photo images. (It could 
cause system overload if access data has many lists with photo images to print or preview. 

2) Input Company, Employee No, Name, and Card No as appropriate. 

3) Select Sort By and Sort Order. 
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4) Select Print button.  If data is found, it will display how it will look when printed.  The following 
screen will appear. 

   

 

5) To obtain print out of this screen, select the Print button  located in the top left hand side. 

 

 

 

 

 

Card Holder Report

Card Holder Report (Detail) 
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 File Conversion 

All reports can be converted to three different types of file.  It can be converted to PDF, HTML, 
and Excel file.  These converted files can be sent out via Internet and email to another person. 

 

 Export to Excel:  Excel report file is created as appearing in print image. 

 Export to HTML:  HTML report file is created as appearing in print image. 

 Export to PDF:  PDF report file is created as appearing in print image.  You will need 
Adobe Acrobat Reader to view the PDF file. 

1) Select the button for the type of file conversion. 

2) The following screen will appear.  Input the file name and designate a folder location. 

  

3) Select Save button.  Depending on file conversion type, it may take some time to complete. 
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There are instances where it may take some time for the procedure to complete, depending 
on conversion file type and number of pages. PDF and Excel file conversion takes some time.  
You will need to wait until   the mouse’s cursor hourglass display is finished. 

4) Once conversion is completed, you can open the converted file to check file image. 

 

 

Opened converted to Excel file 

Opened converted to HTML file 
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 Export 

This function is used to export specified file through Find data for storage. 

Selecting Export button can store data from Find in text and Excel file. 

 

1) Input Search Condition. 

2) Select Export button and the following screen appear. 

Opened converted to PDF file 



 
 
 
 
 
 

STARWATCH DUAL PRO I™ 

172 

 

3) Input file location, name, and select file format.  Select Save button to save. 

 

 

Export in Excel format 

Export in Excel format 
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Delete Card Holder Report 

The reports from deleted card holder in Card Holder Management are searched and printed.  It 
searches and prints data registered in Delete Management. 

 Start 

Select Report->Deleted Card Holder List Report or press shortcut key Ctrl+F5. 

 Print 

This function prints the report of Deleted Card Holder List in agreement with registered deleted 
card holder data. 

 

1) Input Company, Employee No, Name, and Card No as appropriate. 

2) Select Sort By and Sort Order. 

3) Select Print button.  If data is found, it will display how it will look when printed.  The following 
screen will appear. 
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4) To obtain print out of this screen, select the Print button located in the top left hand side. 

 

 Export and Conversion 

These functions are used identically to the methods explained formerly. 

 

Event History Report 

This report is searched as normal access event data of date and time.  This data prints out all users’ 
access record through search.  Use appropriate condition to search and print.  

 Start 

Select Report->Event History Report or press shortcut key Ctrl+F6. 

 Print 

This function prints the report of stored access status data in agreement with search data. 
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1) Input Date (From), Date (To), and time period for each date. 

2) Select other items as appropriate. 

3) Select Print button.  If data is found, it will display how it will look when printed.  The following 
screen will appear. 

 

4) To obtain print out of this screen, select the Print button located in the top left hand side. 
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Alarm History Report 

This report searches and prints alarm event data.  All data related to alarm events are stored in 
database.  Using date and time as Find Condition, the alarm event status is searched and printed. 

 Start 

Select Report->Alarm History Report or press shortcut key Ctrl+F7. 

 Print 

This function prints the report of stored alarm status data in agreement with search data. 

 

1) Input Date (From), Date (To), and time period for each date. 

2) Select other items as appropriate. 

3) Select Print button.  If data is found, it will display how it will look when printed.  The following 
screen will appear. 



 
 
 
 
 
 

STARWATCH DUAL PRO I™ 

177 

 

4) To obtain print out of this screen, select the Print button located in the top left hand side. 

 

Accessible Door List by Person Report  

This report uses Accessible Door as basis to search and print out corresponding access door applied 
to give user authority. 

 Start 

Select Report->Accessible Door List by Person or press shortcut key Ctrl+F9. 

 Print 

It will print out Accessible Door List by Person. 
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1) Input Date (From), Date (To), and time period for each date. 

2) Select other items as appropriate. 

3) Select Print button.  If data is found, it will display how it will look when printed.  The following 
screen will appear. 

It also can be printed according to Report Type. Please select Access Group condition. 

 

4) To obtain print out of this screen, select the Print button located in the top left hand side. 
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Accessible ID Report by Door Report 

This report is to select Accessible ID information according to Door. If you select Door information in 
Find Condition , ID information will be displayed according to Door. 

 Start 

Select Report->Accessible ID Report by Door or press shortcut key Ctrl+F9. 

 Print 

It will print out Accessible Person Report By Door. 

 

1) Input Date (From), Date (To), and time period for each date. 

2) Select other items as appropriate. 

Select Area, Floor, Access Door information. Sort By and Sort Order is optional File  
Condition. 

3) Select Print button.  If data is found, it will display how it will look when printed.  The following 
screen will appear. 
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4) To obtain print out of this screen, select the Print button located in the top left hand side. 

 

Visitor Event List  

This function searches and prints registered visitors’ access event status data.  This data is stored in 
database and the user search and print this data using date and time as basis. 

 Start 

Select Report->Visitor Event History Report or press shortcut key Ctrl+F11. 

 Print 

It will print out Visitor Event List. 
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1) Input Date (From), Date (To), and time period for each date. 

2) Select other items as appropriate. 

3) Select Print button.  If data is found, it will display how it will look when printed.  The following 
screen will appear. 

 

 

4) To obtain print out of this screen, select the Print button located in the top left hand side. 
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Last Access Event Report  

This report is based on Last Access Event data to locate the current site the user is at, using the event 
occurrence data to search and print out. 

This data when used with controller Antipassback function can create accurate data, but if 
Antipassback is not used, the resulting data cannot be seen as accurate. 

 Start 

Select Report->Last Access Event Report or press shortcut key Ctrl+F12. 

 Print 

It will print out Last Access Event Report. 

 

1) Input Date (From), Date (To), and time period for each date. 

2) Select other items as appropriate. 

3) Select Print button.  If data is found, it will display how it will look when printed.  The following 
screen will appear. 
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4) To obtain print out of this screen, select the Print button located in the top left hand side. 

 

 
 

Chapter 

6  STARWATCH DUAL PRO I 
Time & Attendance 

STARWATCH Program Time/Attendance 
 
This chapter explains STARWATCH program Time/Attendance in details. 

Time/Attendance 

Time/Attendance contains basic data configuration to create each individual time and attendance 
information.  You can make inquiries to retrieve the information. 
You must configure this function to use Time/Attendance. 
 

Work Time Definition 

For Work Time Definition, work code is created to configure daily attendance, Saturday attendance, 
lunch hour, extension start hour, and next day standard hour. 
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 Start 

 
Select Time/Attendance->Work Time Definition or press shortcut key Shift + F2. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to edit and delete the existing data. 
 

 
  
1) Select the Work Time Code and input Work Time Name. 

2) Select Find to make an inquiry.  If inquired result is available, the following screen appears. 

 Add 

Add is used to create new data.  Select Add button to add work time through input screen. 

1) The following screen appears after selecting Add. 
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2) Input Work Time Code (It must not be duplicated) 

3) Input Work Time Name. 

4) Configure each Time. 

Overtime is described as work performed after end of work schedule. 

 

5) Once input is completed, select Save button to save data. 

6) Select Normal Break Time Definition button. 
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7) The Work Time Code and Work Time Name cannot be changed. Configure each Time.  

If you want to calculate a break time, check each break time use option. 

8) Once input is completed, select Save button to save data. Select Close button. 

9) Select Saturday Work Break Time Definition button. 

 

10) The Work Time Code and Work Time Name cannot be changed. Configure each Time.  

If you want to calculate a break time, check each break time use option. 

11) Once input is completed, select Save button to save data. Select Close button. 
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12) Select Close button to finish the Work Time Definition. 

 

 Modify 

Modify is used to change existing data.  Find data to modify or to change registered work time 
category. 

Selected data is displayed as below figure in highlighted bar. 

 

1) Select Modify to see the above screen.  The Work Time List contains the same data as the Add 
screen.  Therefore, the Work Time Code cannot be changed. 

2) Modify the setting. 

3) Select Save button to save the modified information.  Select Close button to finish. 

 Delete 

Delete is used to delete existing data.   

Selected data is displayed as below figure in highlighted bar. 
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1)    Select Delete button.  The screen below will appear.  Select Yes button to delete or No button to 
cancel. 

 

Work Holiday Definition 

Work Holiday Definition function configures work holiday to exclude from total attendance calculation. 
 

 Start 

Select Time/Attendance->Work Holiday Definition or press shortcut key Shift+F3. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to modify and delete the existing data. 
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1) Select the appropriate Holiday Code and Holiday Name. 

2) Select Find to make an inquiry.  If inquired result is available, the following screen appears. 

 Add 

Add is used to create new data.  Select Add button to add work holiday through input screen. 

 

1) The following screen appears after selecting Add. 
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2) Input Work Holiday Code. (It must not be duplicated) 

3) Input Work Holiday Name. 

4) Input Work Holiday Date Name. 

5) Select the work holiday date twice or select the date then press >> button. 
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6) From the Selected Work Holiday Date list, delete the date by double clicking or selecting date and 
selecting << button. 

7) Select Save button to save data, and select Close button to finish. 

 Modify 

Modify is used to change existing data.  Find data to modify or to change registered work holiday 
category. 

Selected data is displayed as below figure in highlighted bar. 

  

1) Select Modify button. 

2) Select Modify to see the following screen.  The Work Holiday screen contains the same data as 
the Add screen.  Therefore, the Work Holiday Code cannot be changed, except the holiday date 
included in selected holiday code. 
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Modify the items to be changed. 

3) Select Save button to save data, and select Close button to finish. 

 Delete 

Delete is used to delete existing data.  Find data to delete or to delete registered work holiday list 
data. 

Selected data is displayed as below figure in highlighted bar. 

.  

1) Select Delete button.  The screen below will appear.  Select Yes button to delete or No button to 
cancel. 
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Work Type Definition 

Work Type Definition configures late, leaving early, absence, business trip into work type code. 

 Start 

Select Time/Attendance->Work Type Definition or press shortcut key Shift+F4. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to modify and delete the existing data information. 

 

1) Select the appropriate Work Type Code and Work Type Name. 

2) Select Find to make an inquiry.  If inquired result is available, the following screen appears. 

If find has no specific parameters, it will display the entire information. 

 

 Add 

Add is used to create new data.  Select Add button to add work type data through input screen. 
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1) Select Add button and the following screen appear.  

 

 

2) Input Work Type Code. 

3) Input Work Type Name. 

4) Select Save button to save data. 

5) Select Close button to finish. 

 Modify 

Modify is used to change existing data.  Find data to modify or to change registered work type list. 

Selected data is displayed as below figure in highlighted bar. 
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1) Select Modify to see the following screen.  The Work Type Definition screen contains the same 

data as the Add screen.  Therefore, the Work Type Code cannot be changed. 

 

2) Modify Work Type Name. 

3) Select Save button to save data. 

4) Select Close button to finish. 

Work Type Code 01, 02, 03, and 04 is configured as default value for Normal, Late, 
Absence, and Holiday work.  This value cannot be modified or deleted. 

 Delete 

Delete is used to delete existing data.  Find data to delete or to delete registered work holiday list 
data. 

Selected data is displayed as below figure in highlighted bar. 
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1) Select Delete button.  The screen below will appear.  Select Yes button to delete or No button to 
cancel. 

 

Time / Attendance Option Definition 

 To manage Time & Attendance, the Time & Attendance Definition must be registered. 

 Management Mode Definition. 

 

1) Select Check Mode Management to manage the Time & Attendance. 

If you select the First/Last time, Time & Attendance is only calculated by first/last time.  In 
other words, the first time is the work-in time based on Work time. At selecting the 
Function key, Time & Attendance is calculated by set value of function key. If F1 is set by 
Work-In, Work-In Time is the first time using F1 and if F2 is set by Work-Out, Work-Out 
Time is the last time using F2. If you select the In/Out Reader, Work–In time is the first 
time read IN reader. And Work-Out time is the last time read OUT reader. 
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In case of Break Time management function, in that case you have to use Function 
key mode. And also you need to define each function key using Function Key 
Definition windows. Normally F1 is Work In, F2 is Work out, F3 is Break Start and F4 
is Break End.  

                                                                                                                                                       

 Reader Option 

Time & Attendance Group is managed by Work Team. So, calculate Time & Attendance using 
Event data through reading readers included Time & Attendance Group. 

   

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  
It is used to modify and delete the existing data.  
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1) Input Group Code and Group Name as appropriate. 

2) Select Find to make an inquiry.  If inquired result is available, the following screen 
appears. 

 Add 

Add is used to create new data.  Select Add button to add Time & Attendance Group through 
input screen. 

 

1) The following screen appears after selecting Add. 
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2) Input Group Code.  Do not overlap this code. 

3) Input Group Name. 

4) Double click the Time & Attendance Door from Available Time & Attendance            Door 
List, or select >> button to register. 

5) Repeat the above method to register additional Time & Attendance Group. 

Cancel Time & Attendance Door by double clicking on selected door or select << button. 

  

6) Select Save button to save data, and select Close button to finish. 

 Modify 
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Modify is used to change existing data.  Find data to modify or to change registered group 
category. 

Selected data is displayed as below figure in highlighted bar. 

  

1) Select Modify to see the following screen.  The Access Group is equal to registration screen.  
Therefore, the Access Group Code cannot be changed. 

 
 
2) Modify the items that need changing. 

3) Select Save button to save the modified information.  Select Close button to finish. 

 Delete 

Delete is used to delete existing data.  Find data to delete or to delete registered content data. 

Selected data is displayed as below figure in highlighted bar. 
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1) Select Delete button.  The screen below will appear.  Select Yes button to delete or No button to 
cancel. 

 

 

 Function Key Definition 

 Define the value of Function Key. 

  

  This value is used when Time & Attendance is calculated by function key. 
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Daily Data Management 

Daily Data Management creates data from individually configured work time and work holiday using 
present normal access event data.  This is called daily end data. 

 Start 

Select Time/Attendance->Daily Data Management or press shortcut key Shift+F5. 

 Create Work Data  

Create Work Data creates data from individually configured work time and work holiday using 
normal access event data.  The created data is differentiated from normal access event, and 
saved as a separate data. 

 

1) Select the From/To date for creating work data. 
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2) Select Create Data button to begin work data. 

If there is no data, it will display a message as no data.  If there is data, a progress bar is shown in 
relation to data creation progress. 

3) Once completed, select OK button to finish data creation. 

 Find Daily Work Data 

Find Daily Work Data is used to get relevant information pertaining to the inquiry when information 
is available.  It is used to modify existing data information to send out, or when incorrect 
attendance data is found. 

 

1) Select the From/To date for creating work data. 
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2) Sort by date, company, department, employee ID, name, and attendance type as appropriate. 

3) Select view format. 

4) Select as View Minute or View Hour to see late, absence, overtime, and special duty by 
attendance type. 

5) Select Find to make inquiry.  If result is found, the data is displayed. 

 

 Abnormal Attendance Data Modification 

After performing work data, you can check the daily attendance result by inquiry.  If modification is 
needed, double click the result to open the modification screen. 

 

Click the data to be modified with double click 
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1) Select the data to be modified with 2 selects on a mouse.  It will activate the screen below. 

 

2) Entry Date, Employee ID, and Name cannot be modified.  Work IN Date/Time, Work OUT 
Date/Time, Late, Early Leave, Overtime, Extra Time, and Work Type can be modified. 

3) If No Update is selected, the work data performed once more will not update the modified data. 

4) If modification is completed, select Save button to save data. 

5) Select Close button to finish. 

If the work-closing will be updated, event data is resorted by time & attendance setting value. 
But this will be available to update for event data when the modification date is the same of 
original entry date, otherwise it can not be update if the user check for invalid update when 
the all data closing.  

 

If modifying attendance data, you need to find the data results in minutes.  Otherwise, 
the data results in hour cannot be modified.  Find the data results in minutes to allow 
modification to the attendance data. 

Monthly work data uses Daily work data as basis.  If daily work data is modified, it 
will reflect to monthly work data. 

 Export 

This function sends out work data as text file or Excel file format.  The files exported can be used 
in other attendance and wage programs, or connected to an ERP system to be used efficiently. 
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1) Select Find button to make inquiry. 

2) Select Export button and the following screen appear. 

 

3) Designate folder to save into. 

4) Input file format. 

5) Select text file or Excel file for export format. 

6) Select Save button to save file. 

If text file is selected for export, the following screen appears.  
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Monthly Data Management 

Monthly Data Management uses work data as basis to get total of individual type monthly attendance 
data. 

 Start 

Select Time/Attendance->Monthly Data Management or press shortcut key Shift+F6. 

 Create Data 

Work data is used as basis to create Monthly Work Data.  Work data’s monthly total data is 
created by individual type monthly total data. 

 

1) Select Monthly Work Data.  This data is calculated using time attendance option configuration as 
basis.  If configuring date as 25th end date, it will calculate from last month 26th up to selected month 
of 25th as end date. 

2) Select Create Data button begin data creation. 
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 Find Monthly Work Data 

This is used to find data created in Monthly Work Data. 

 

1) Select Month, Company, Department, Employee ID, and Name as appropriate. 

2) Select view option as View Minute or View Hour. 

3) Select Find button to begin Monthly Work Data inquiry.  If data is found, it will display in the screen. 
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 Exporting Monthly Work Data 

Monthly Work Data can be exported in same manner as Work Data.  It can be sent as text file or 
Excel file to be used in other programs. 

Yearly Data Management 

Yearly Data Management uses Monthly Data as basis to calculate total annual time attendance data 
for data creation.  Data to be created is agreed with Monthly Data. 

 Start 

Select Time/Attendance->Yearly Work Data or press shortcut key Shift+F7. 

 Create Data 

Monthly data is used as basis for selected year’s monthly total data to create time attendance data. 
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1) Select Year for yearly data. 

2) Select Create Data button to begin yearly work data creation. 

 Find Yearly Work Data 

       This finds the completed yearly work data through inquiry.  It is used to check yearly work data or 
exporting the data. 

 

1) Select Year, Company, Department, Employee ID, and Name as appropriate. 

2) Select view option as View Minute or View Hour, then select Find button. 

If data is found, it will display as following screen. 
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 Exporting Yearly Work Data 

Yearly Work Data can be exported in same manner as Work Data.  It can be sent as text file or 
Excel file to be used in other programs. 

 

Break Time Management 

To use Break Time Management correctly should use Function key mode. Otherwise, 
the data may not correct data. 

Break Time Management search data from individually configured work time and work holiday using 
daily end data. 

 Start 

Select Time/Attendance->Break Time Management or press shortcut key Shift+F8. 

 Find Break Time Data 

Find Break Time Data is used to get relevant information pertaining to the inquiry when 
information is available.  It is used to modify existing data information to send out, or when 
incorrect break time data is found. 
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1) Select the From/To date for creating work data. 

2) Sort by date, company, department, employee ID, name, and attendance type as appropriate. 

3) Select view format. 

4) Select as View Minute or View Hour  

5) Select Find to make inquiry.  If result is found, the data is displayed. 

 

 Abnormal Break Time Data Modification 

After performing work data, you can check the break time data result by inquiry.  If modification is 
needed, double click the result to open the modification screen. 
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1) Select the data to be modified with 2 selects on a mouse.  It will activate the screen below. 

 

2) 1st Break Start Time, 1st Break End Time, 1st Exception Time, 2nd Break Start Time, 2nd Break End 
Time, 2nd Exception Time, 3rd Break Start Time, 3rd Break End Time, 3rd Exception Time, 4th Break 
Start Time, 4th Break End Time, 5th Break Start Time, 5th Break End Time, 5th Exception Time can 
be modified. 

3) If modification is completed, select Save button to save data. 

4) Select Close button to finish. 

 

 Export 
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This function sends out work data as text file or Excel file format.  The files exported can be used 
in other attendance and wage programs, or connected to an ERP system to be used efficiently. 

 

1) Select Find button to make inquiry. 

2) Select Export button and the following screen appear. 

 

3) Designate folder to save into. 

4) Input file format. 

5) Select text file or Excel file for export format. 

6) Select Save button to save file. 

If text file is selected for export, the following screen appears.  
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Attendance Report (Individual/Daily) 

Individual/Daily Report is outputted using work attendance data as basis.  This report displays Start 
work, Finish work, Late, Leave, Absence, and abnormal attendance modified data. 

 Start 

Select Time/Attendance->Individual/Daily Report or press Shift + F9 on keyboard. 

 Find and Print 
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Input Find Condition to print appropriate data.  Input the conditions in the top part of screen, and 
how the report will be printed can be seen at the bottom part of screen. 

 

1) Select type of Attendance Report. 

Individual Attendance Report find is From/To date of individual type data.  Daily 
Attendance Report find is From/To date of daily type data. 

2) Input Find Condition. 

3) Select Print button.  If data is found, it will display how it will look when printed.  The following 
screen will appear. 

 

Individual Attendance Report 
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4) To obtain print out of this screen, select the Print button located in the top left hand side.   

You can operate the buttons next to the Print to zoom, compress, view multiple pages, and other 
options through these icons. 

 File Conversion (Export) 

All reports can be converted to variety of files.  It can be converted to PDF, HTML, and Excel file.  
These converted files can be sent out via Internet and email to another person. 

 

 Export To Excel:  Excel report file is created as appearing in print image. 

 Export To HTML:  HTML report file is created as appearing in print image. 

Daily Attendance Report 
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 Export To PDF:  PDF report file is created as appearing in print image.  You will need 
Adobe Acrobat Reader to view the PDF file. 

1) Select the button for the type of file conversion. 

2) The following screen will appear.  Input the file name and designate a folder location. 

 

3) Select Save button.  Depending on file conversion type, it may take some time to complete. 

There are instances where it may take some time for the procedure to complete, 
depending on conversion file type and number of pages. 

PDF and Excel file conversion takes some time.  You will need to wait until the 
mouse’s cursor hourglass display is finished. 

4) Once conversion is completed, you can open the converted file to check file image. 
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Opened converted to Excel file 

Opened converted to HTML file 
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Attendance Report (Monthly/Yearly) 

Monthly/Yearly report can be printed using Monthly Data and Yearly Data as basis.  This report is total 
calculation of Monthly and Yearly work attendance data.  Through detailed report, Monthly report can 
be checked by individual type of 1 month time attendance. 

 Start 

Select Time/Attendance->Report->Monthly/Yearly Report or press Shift + F11 on keyboard. 

 Find and Print 

Input Find Condition to print appropriate data.  Input the conditions in the top part of screen, and 
how the report will be printed can be seen at the bottom part of screen. 

Opened converted to PDF file 
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1) Select Attendance Report type. 

Monthly Attendance Report uses as basis Monthly Work Data to display monthly 
attendance by individual type.  Monthly Attendance Report (Day by Day) displays one 
month attendance at once to check data. 

Yearly Attendance Report uses Yearly Work Data to display current time attendance, 
and the data is agreed with Monthly Attendance Report. 

2) Input Find Condition. 

3) Select Print button.  If data is found, it will display how it will look when printed.  The following 
screen will appear. 
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4) To obtain print out of this screen, select the Print button located in the top left hand side. 

You can operate the buttons next to the Print to zoom, compress, view multiple pages, and other 
options through these icons. 

 File Conversion (Export) 

All reports can be converted to variety of files.  It can be converted to PDF, HTML, and Excel file.  
These converted files can be sent out via Internet and email to another person. 

Monthly Attendance Report 

Yearly Attendance Report 
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 Export To Excel:  Excel report file is created as appearing in print image. 

 Export To HTML:  HTML report file is created as appearing in print image. 

 Export To PDF:  PDF report file is created as appearing in print image.  You will need 
Adobe Acrobat Reader to view the PDF file. 

1) Select the button for the type of file conversion. 

2) The following screen will appear.  Input the file name and designate a folder location. 

 

3) Select Save button.  Depending on file conversion type, it may take some time to complete.  

There are instances where it may take some time for the procedure to complete, 
depending on conversion file type and number of pages. 

PDF and Excel file conversion takes some time.  You will need to wait until the 
mouse’s cursor hourglass display is finished. 
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Break Time Report (Daily) 

Break Time Report is outputted using work attendance data as basis.  This report displays Break Start 
Time, Break End Time, and Break Exception time and abnormal attendance modified data. 

 Start 

Select Time/Attendance->Break Time Report or press Shift + Ctrl + F1 on keyboard. 

 Find and Print 

Input Find Condition to print appropriate data.  Input the conditions in the top part of screen, and 
how the report will be printed can be seen at the bottom part of screen. 

  

1) Input Find Condition. 

2) Select Print button.  If data is found, it will display how it will look when printed.  The following 
screen will appear. 
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3) To obtain print out of this screen, select the Print button located in the top left hand side.   

You can operate the buttons next to the Print to zoom, compress, view multiple pages, and other 
options through these icons. 

 File Conversion (Export) 

All reports can be converted to variety of files.  It can be converted to PDF, HTML, and Excel file.  
These converted files can be sent out via Internet and email to another person. 

Break Time Report  

Break Time Report 
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 Export to Excel:  Excel report file is created as appearing in print image. 

 Export to HTML:  HTML report file is created as appearing in print image. 

 Export to PDF:  PDF report file is created as appearing in print image.  You will need 
Adobe Acrobat Reader to view the PDF file. 

1) Select the button for the type of file conversion. 

2) The following screen will appear.  Input the file name and designate a folder location. 

 

3) Select Save button.  Depending on file conversion type, it may take some time to complete. 

There are instances where it may take some time for the procedure to complete, depending 
on conversion file type and number of pages. 
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PDF and Excel file conversion takes some time.  You will need to wait until the mouse’s 
cursor hourglass display is finished. 

4) Once conversion is completed, you can open the converted file to check file image. 

 

 

Opened converted to Excel file 

Opened converted to HTML file 
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Break Time Report (Monthly/Yearly) 

Monthly/Yearly report can be printed using Monthly Data and Yearly Data as basis.  This report is total 
calculation of Monthly and Yearly work attendance data.  Through detailed report, Monthly report can 
be checked by individual type of 1 month time attendance. 

 Start 

Select Time/Attendance->Report->Monthly Break Report or press Shift + Ctrl + F2 on keyboard. 

 Find and Print 

Input Find Condition to print appropriate data.  Input the conditions in the top part of screen, and 
how the report will be printed can be seen at the bottom part of screen. 

Opened converted to PDF file 
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1) Select Break time Report type. 

Monthly Break time Report uses as basis Monthly Break Time Data to display monthly 
attendance by individual type.  Monthly Break Time Report (Day by Day) displays one month 
Break time data at once to check data. 

Yearly Break Time Report uses Yearly Break Time Data to display current time attendance, 
and the data is agreed with Monthly Break time Report. 

2) Input Find Condition. 

3) Select Print button.  If data is found, it will display how it will look when printed.  The following 
screen will appear. 

 

Monthly Attendance Report 
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4) To obtain print out of this screen, select the Print button located in the top left hand side. 

You can operate the buttons next to the Print to zoom, compress, view multiple pages, and other 
options through these icons. 

 File Conversion (Export) 

All reports can be converted to variety of files.  It can be converted to PDF, HTML, and Excel file.  
These converted files can be sent out via Internet and email to another person. 

 

 Export to Excel:  Excel report file is created as appearing in print image. 

 Export to HTML:  HTML report file is created as appearing in print image. 

Yearly Attendance Report 
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 Export to PDF:  PDF report file is created as appearing in print image.  You will need 
Adobe Acrobat Reader to view the PDF file. 

1) Select the button for the type of file conversion. 

2) The following screen will appear.  Input the file name and designate a folder location. 

 

3) Select Save button.  Depending on file conversion type, it may take some time to complete.  

There are instances where it may take some time for the procedure to complete, depending 
on conversion file type and number of pages. 

PDF and Excel file conversion takes some time.  You will need to wait until the mouse’s 
cursor hourglass display is finished. 

 
 

 



 
 
 
 
 
 

STARWATCH DUAL PRO I™ 

232 

 

Chapter 

7 
  STARWATCH DUAL PRO I 
TCP/IP Communication 

DUAL PRO™ TCP/IP Communication 
 
This chapter explains TCP/IP communication explanation, along with 
detailed configuration instruction and usage with STARWATCH DUAL 
PRO I™ 

TCP/IP Communication  

TCP/IP communication takes place of existing serial communication, by using the already established 
network to communicate with the ACU device and program.  
 
TCP/IP communication method supported by ACU is 1 type. There is an external converter called 
Neteye1000S using TCP/IP. 
 
Neteye1000S RS422 communication with TCP/IP communication from program to device can be 
networked.  It can connect 32 ACU devices via RS422 for operation.  
 
For instance, if using external type converter, each converter can connect 32 units. In this case, one fixed 
IP is needed for the external TCP/IP converter. 
 
 

In Usage with External TCP/IP converter 

If using external converter, it can connect up to maximum of 32 ACU devices. In this case, the 
communication must be connected via RS422 method. You can use RS232 or RS422 if external converter 
has only 1 unit of ACU connected.  
 
Connection method for external converter in RS232/RS422 is a bit different in wire connection and Piano 
Switch. 
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Communication via RS232 

RS232 connection must be done in the following. Use a 9 pin female connector to the ACU device 
RS232 communication as shown below. 

 Connection 

ACU device cable 9 pin connector  
TXD #2 pin (RXD) 

RXD #3 pin (TXD) 

GROUND #5 pin (GRD) 
 

 Piano Switch Configuration 

 

Switch # Switch Status 
1 On(Down) 

2 Off(Up) 

3 On(Down) 

4 Off(Up) 

5 On(Down) 

6 Off(Up) 
 

 



 
 
 
 
 
 

STARWATCH DUAL PRO I™ 

234 

 

Communication via RS422 

RS422 connection must be done in the following.  Use a 9 pin female connector to the ACU device 
RS422 communication as shown below. 

 Connection 

ACU device 9 pin connector 
TX+  #2 pin (RX+) 

RX+ #3 pin (TX+) 

TX- #7 pin (RX-) 

RX- #8 pin (TX-) 
 

 Piano Switch Configuration 

 

    

Switch # Switch Status 
1 Off(Up) 
2 On(Down) 
3 Off(Up) 
4 On(Down) 

5 Off(Up) 

6 On(Down) 
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External Converter Configuration Program  

Using an external converter for TCP/IP communication requires a configuration program, along with 
an IP and some configuration processes. 

 Program Installation 

The CD provided contains LAN converter IP configuration and operation status check.  

Install the program to configure the LAN converter IP from the PC. 

1) Locate the NetEye1000_Setup.exe file in the CD and select on it to begin installation. 

 

 
 

2) Select Next button to move on to following step. 

 

 
 

3) Check the folder the program will be installed on to, then select Install button to begin. 
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4) Once installation is completed, select OK button to finish. 

 

 IP Configuration 

Select Start->Program->NetEye1000 to run program. 
 
Once programming is running, it will display the following screen showing all LAN converters 
connected to the network. 
 
The figure below shows 2 LAN converters connected. 

 

 

Each LAN converter needs to configure IP, Gateway, Subnet Mask, and Port.  From the above 
figure, selecting the converter to be configured by double clicking will display the following screen. 
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User needs to configure the above categories with a value.  Modify the IP Address, 

Gateway, Subnet Mask, but leave the rest with default values. 

 

 

Category Setup Value 
Mode Server 

IP Address IP Address received from network(No Duplication) 

Gateway Gateway received from network 

Subnet Mask Subnet Mask received from network 

Port 5000 

BPS 9600 

Parity None 

Data bit 8 

Stop bit 1 
   

 

  Select OK button to finish configuration. 
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S/W Configuration 

 

Loop Definition 

Port definition describes Serial and TCP/IP communication loop connected to the PC.  It supports up 
to 99 Loops, but keep in mind depending on PC performance, memory, and OS, supporting 99 Loops 
may not be possible.  It is recommended to use adequate number of Loops for usage. 

 Start 

Select Set Up-> Loop Definition or press Ctrl+A button on keyboard. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to edit and delete the existing data information. 

  

1)   Select Loop No. and Comm. Type as appropriate. 

2)  Select Find to make an inquiry.  If inquired result is available, the following screen appears. 

If find has no specific parameters, it will display the entire information 

Find Add, Modify and Delete functions are all applied equally in input/output screen.  Once 
you familiarize these functions, you can easily understand them as they are used equally in 
other input/output screens. 
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 Add 

Add is used to create new data.  Select Add button to add work type data through input screen. 

 

1) Select Add button and the following screen appear. 

 

1) Select Loop No and it will indicate Loop No not used.  The Loop No. being used will not be 
displayed. 

2) Select Comm. Type as Serial Chain for Serial, TCP/IP Chain for TCP/IP and Dial-UP Chain for 
Dial-Up as communication type. 

3) Check mark Active for the correspond port to be able to communicate. 

Decide if correspond port will be active for communication.  Active check mark Loop No 
communicates, but without a check mark will result in no communication. 
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This option lets the user make the port inactive, if the port requires maintenance due to a 
problem in communication.  User can fix the problem while other locations remain with active 
ports. 

If the port data is modified, you must close the program and restart. 

1) Select from Serial Chain tab, Comm. Port, Speed, Parity Bit, Data Bit, and Stop Bit.  The default 
value is Speed 9600, Parity Bit None, Data Bit 8, and Stop Bit 1 for configuration. 

2) Input screen changes if TCP/IP Chain is selected. 

 

Input the IP Address from the external converter for configuration. 

Input TCP Loop No. as default value 5000. (Port No. is fixed at 5000) 

Select Module Type as external version. 

For detailed instructions on TCP/IP communication, refer to chapter 7 STARWATCH DUAL PRO 
I™ TCP/IP Communication. 

3) Input screen changes if Bypass TCP/IP Chain is selected. 
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      Bypass TCP/IP Chain is used when connecting with WebEye Device. 

      To use Surveillance monitoring, WebEye Device should be used. 

      WebEye Device can not only connect with camera and also can communicate 

      Like converter. So if you want to use WebEye Device there are couple of things 

      to input. 

      WebEye Device is communicate by TCP/IP, so you should input IP Address, Port  

      No. And Device ID, Device Password, Com Port, Speed, Parity Bit, Data Bit, Stop bit. 

      We recommend to read View Pro Installation Guide about detail information. 

4) Select Save button to save  data, and select Close button to finish. 

 Modify 

Modify is used to change existing data.  Find data to modify or to change registered work time 
category. 

Selected data is displayed as below figure in highlighted bar. 
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1)  Select Modify to see the above screen.  The Port List is equal to registration screen.  Therefore, the 
Loop No. cannot be modified. 

 

2)  Modify the items that need changing.  Once completed, select Save button to save the modify data.  

3) Select Close button to finish. 

 Delete 

Delete is used to delete existing data.  Find data to delete or to delete registered category list data. 

Selected data is displayed as below figure in highlighted bar. 
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1)  Select Delete button.  The screen below will appear.  Select Yes button to delete or No button to 
cancel. 

 

Deleting the registered port will erase all data of controller, access door, and reader.  Please 
use extreme caution when using this function. 

Controller Definition 

Controller Definition explains data definition of controller.  Each controller has its own communication 
address.  By address type, the S/W data is defined and communicated.  Also, each controller can 
have its own function options, and these options are sent to the controllers for application. 

Complete all initial setup and reboot the program, and make certain communication is established 
before using transmit function. 

 Start 

Select Set Up->Controller Definition or press Ctrl+B button on keyboard. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to edit and delete the existing data information. 
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1) Select Loop No. and Controller No. as appropriate. 

2) Select Find to make an inquiry.  If inquired result is available, it will display the results. 

If find has no specific parameters, it will display the entire information  

 Add 

Add is used to create new data.  Select Add button to add work type data through input screen. 

 

1)  Select Add button and the following screen will appear. 
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2)  Select Loop No.  It displays only the Loop No. that was registered in Loop Registration. 

3)  Unregistered Controller No. List displays items not selected from Loop No.  Select the Controller 
No. to be registered choosing and selecting >> button or double click the Controller No. to select 
and it will show up on the right hand side Registered Controller No. List.  

Controller registration must be done one at a time to setup.  

It will register one controller number with its basic data for configuration.  Select Save button 
to complete the process. 

Repeat the procedure to add additional controllers. 

Select Controller Type as controller type.  

4) Input Controller Name.  This is a must in order to define the location, when an event occurs to a 
controller. 

5) Configure card memory.  Depending on card memory setup, the event memory is automatically 
setup.  Configure adequate amount of card and event memory. 

6) After setup is completed in ‘Set Card ID Memory’, please click ‘Function Setting’ tab. Following 
screen will be shown up. 
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7) These items in ‘Function Setting’ is Type in Controller and user can select the type.  

a. Stand Alone is used to select whether new data will be filed or ignored when memory is 
full. Default value is ‘Not Use’ 

b. Finger007P is used to select whether Pin mode will be activated or no. Default value is 
‘Not Use’ 

c. Dual Finger is used to register fingerprint in registration mode whether single fingerprint is 
used or dual fingerprints are used. Default value is ‘Not Use’ 

d. Adaptive Mode is used to enhance fingerprint verification rate. Default value is ‘Use’ 

e. Identification is used to access door only by fingerprint. Default value is ‘Not Use’ 

f. LCD Display is to select whether access status will be shown up or card number will be 
shown up. Default value is ‘Status’ 

g. You can set Output Time 1Sec or 0.1Sec. Default value is 1Sec. 

8) Select Save button to save data. 

9) Select Transmit button to send setup data to controller for memory setup. 

When setup is performed for all controller, program, and related data, it is not active until 
transmitted to controller.  It is possible the transmit function may not work properly.  

10) Select Close button to finish. 

 Modify 

Modify is used to change existing data.  Find data to modify or to change registered controller 
category. Selected data is displayed as below figure in highlighted bar. 
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1) Select Modify to see the following screen.  The Controller Modify is equal to registration screen.  
However, the Loop No cannot be changed, and modify is possible to the selected controller 
address. 

A. 

  

B. 
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Modify the items that need changing. And 505R and ICON100 can be changed only LCD Display 
and Output Time in ‘Function Setting’. 

2) Select Save button to save the modified information.   

3) Select Transmit button to send setup data to controller for memory setup. 

When setup is performed for all controller, program, and related data, it is not active until 
transmitted to controller.  It is possible the transmit function may not work properly. 

4) Select Close button to finish. 

 Delete 

Delete is used to delete existing saved data.  Find data to delete or to delete registered controller 
category data. Selected data is displayed as below figure in highlighted bar. 
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1) Select Delete button.  The screen below will appear.  Select Yes button to delete or No button to 
cancel. 

 

Deleting the registered controller will erase all data of controller, access door, and reader.  
Please use extreme caution when using this function. 

 

 

 

 Transmit 

This function is used to send the setup functions to the controller for activation.  Use Find to 
search for data transmit or select the data from the registered controller categories to send. 

Selected data is displayed as below figure in highlighted bar. 
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1) Select Transmit button.  This will send the selected data to the corresponding Controller No for 
application. 

If an error does occur, detailed explanation is displayed in a message box. 

In this case, retransmit the data, but if the error continues, check the communication and controller for 
problems. 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 
 
 
 
 

STARWATCH DUAL PRO I™ 

251 

Chapter 

8 
 STARWATCH DUAL PRO I 
Dial Up Communication 

DUAL PRO™ Dial-Up Communication 
 

This chapter explains Dial-Up communication explanation, along with 
detailed configuration instruction and usage with Dual Pro™ program. 

System Requirement 

Dial-Up communication requires some devices for operation.  It needs 2 modems for host and remote 
site connection. 
 
Modem must be an external version for use, and the ability to auto answer function (Namely, when the 
host calls the remote modem, it answers to make connection) 
 
The DUAL PRO™ system supports the following modem, and as possible uses this modem.  Also, to 
have Dial-Up communication, it requires making of a separate communication cable one for the host 
site and one for the remote site. 
 
• 3Com U.S Robotics 56K Fax External Modem 2 (Remote Site, Host Site) 
• Host, Remote Serial communication Cable 

Dial-Up Communication Layout 

 

 
Telephone Line 

Max32 

RS232C Host Cable 
Host Computer 
(With DUAL PRO™ Access Control Program)

RS232C Remote Cable 

Host Site 

Converter (RS422/RS232) 

Remote Site 
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Modem Configuration 

Some configurations are required to setup the host and remote modem for operation.  Configuration 
for communication speed and auto answer function is required. 
 
To configure the modem, it needs the manual, driver, and modem cable included in the modem 
package. 
 
To configure the modem environment, it requires the Hyper Terminal included in Windows. 
 
If Hyper Terminal is not installed, go to Control Controller and open Program Add/Delete file to install 
the program. 
 

Host Modem Setup  

To setup the Host Modem, all you need to do is modify the communication speed using the driver and 
cable. 

 Communication Speed Setup 

This function is used to calibrate communication speed between ACU device and modem to be 
equal.  When the modem is first installed, the speed value is setup at maximum speed.  However, 
ACU device speed is 9600BPS, so the modem speed needs to be setup as 9600BPS for 
configuration. 

1) Install the modem to Window 2000 or XP, and then install the driver for modem recognition. 

2) Go to Control Panel and select Phone and Modem file.  Select on modem properties and change 
the speed to 9600bps.  (After driver installation, the speed is automatically setup at 115200bps) 

3) Use Hyper Terminal to send Initialize Command (ATZ) to the modem, and check the message 
OK appears. 

4) Once the above process is completed, turn the power off and disconnect cable for setup 
completion. 

Remote Modem Setup  

To configure the Remote Modem, it needs the driver and modem cable included in the modem 
package to setup the communication speed and auto answer. 

 Communication Speed Setup 

1) Install the modem to Window 2000 or XP, and then install the driver for modem recognition. 

2) Go to Control Controller and select Phone and Modem file.  Select on modem properties and 
change the speed to 9600bps.  (After driver installation, the speed is automatically setup at 
115200bps) 

3) Use Hyper Terminal to send Initialize Command (ATZ) to the modem, and check the message 
OK appears. 
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4) Once the above process is completed, turn the power off and disconnect 
cable for setup completion. 

 Auto Answer Setup 

1) Use Hyper Terminal to send Initialize Command (ATZ) to the modem, and check the message 
OK appears. 

2) When OK message appears, input ATS0=1 and check the message OK appears. 

3) When OK message appears, input AT&W and check the message OK appears. 

4) Once the above process is completed, turn the power off and disconnect 
cable for setup completion. 

 

Serial Interface Pin Definitions 

DB-25 DB-9 Circuit Function Signal Source 
Computer/Modem 

1 - AA Chassis Ground Both 
2 3 BA Transmitted Data Computer 
3 2 BB Received Data Modem 
4 7 CA Request to Send Computer 
5 8 CB Clear to Send Modem 
6 6 CC Data Set Ready Modem 
7 5 AB Signal Ground Both 
8 1 CF Carrier Detect Modem 
12 - SCF Speed Indicate Modem 
20 4 SD Data Terminal Ready Computer 
22 9 CE Ring Indicate Modem 

 
 
 
 
 
 
 
 
 
 
 

Cable 

Dial-Up communication requires a separate making of a cable.  Host and Remote cable making 
process is different to each other.  Refer to the wire layout below for the procedure. 
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Host Cable 

 
 

Remote Cable 
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S/W Configuration 

Loop Definition 

Port definition describes Serial and TCP/IP communication loop connected to the PC.  It supports up 
to 99 Loops, but keep in mind depending on PC performance, memory, and OS, supporting 99 Loops 
may not be possible.  It is recommended to use adequate number of Loops for usage. 

 Start 

Select Set Up-> Loop Definition or press Ctrl+A button on keyboard. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to edit and delete the existing data information. 

  

1) Select Loop No. and Comm. Type as appropriate. 

2) Select Find to make an inquiry.  If inquired result is available, the following screen appears. 

If find has no specific parameters, it will display the entire information 

Find Add, Modify and Delete functions are all applied equally in input/output screen.  Once 
you familiarize these functions, you can easily understand them as they are used equally in 
other input/output screens. 

 

 Add 

Add is used to create new data.  Select Add button to add work type data through input screen. 
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1) Select Add button and the following screen appear. 

 

2) Select Loop No and it will indicate Loop No not used.  The Loop No. being used will not be 
displayed. 

3) Select Comm. Type as Serial Chain for Serial, TCP/IP Chain for TCP/IP and Dial-UP Chain for 
Dial-Up as communication type. 

4) Check mark Active for the correspond port to be able to communicate. 

Decide if correspond port will be active for communication.  Active check mark Loop No 
communicates, but without a check mark will result in no communication. 

This option lets the user make the port inactive, if the port requires maintenance due to a 
problem in communication.  User can fix the problem while other locations remain with active 
ports. 
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If the port data is modified, you must close the program and restart. 

5) Select from Serial Chain tab, Comm. Port, Speed, Parity Bit, Data Bit, and Stop Bit.  The default 
value is Speed 9600, Parity Bit None, Data Bit 8, and Stop Bit 1 for configuration. 

6) Input screen changes if TCP/IP Chain is selected. 

 

Input the IP Address from the external converter for configuration. 

Input TCP Loop No. as default value 5000. (Port No. is fixed at 5000) 

Select Module Type as external version. 

For detailed instructions on TCP/IP communication, refer to chapter 7 STARWATCH DUAL PRO 
I™ TCP/IP Communication. 

7) Input screen changes if Bypass TCP/IP Chain is selected. 
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      Bypass TCP/IP Chain is used when connecting with WebEye Device. 

      To use Surveillance monitoring, WebEye Device should be used. 

      WebEye Device can not only connect with camera and also can communicate 

      Like converter. So if you want to use WebEye Device there are couple of things 

      to input. 

      WebEye Device is communicate by TCP/IP, so you should input IP Address, Port  

      No. And Device ID, Device Password, Com Port, Speed, Parity Bit, Data Bit, Stop bit. 

      We recommend to read View Pro Installation Guide about detail information. 

8) Select Save button to save  data, and select Close button to finish. 

 Modify 

Modify is used to change existing data.  Find data to modify or to change registered work time 
category. 

Selected data is displayed as below figure in highlighted bar. 
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1) Select Modify to see the above screen.  The Port List is equal to registration screen.  Therefore, 
the Loop No. cannot be modified. 

 

2) Modify the items that need changing.  Once completed, select Save button to save the modify 
data.  

3) Select Close button to finish. 

 Delete 

Delete is used to delete existing data.  Find data to delete or to delete registered category list data. 

Selected data is displayed as below figure in highlighted bar. 
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1) Select Delete button.  The screen below will appear.  Select Yes button to delete or No button to 
cancel. 

 

Deleting the registered port will erase all data of controller, access door, and reader.  Please 
use extreme caution when using this function. 

Controller Definition 

Controller Definition describes ACU board’s data configuration. 

Each ACU device has its own communication address.  Data is configured in S/W to each address to 
communicate with ACU. Each ACU can be configured with a variety of function options by sending the 
data for application. 

 Start 

Select Set Up->Controller Definition or press shortcut key Ctrl+B. 

 Add 

Add is used to create new data.  If adding additional Controllers, select Add button and input data 
in the following screen.  
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1) Select Add button and the following screen appear. 

  

2) Select Loop No.  It displays only the Loop No that was registered in Loop Registration. 

3) Unregistered Controller No. List displays items not selected from Loop No.  Select the Board No 
to be registered choosing and selecting >> button or double click the Board No to select, and it will 
show up on the right hand side Registered Controller No List. 

 Controller registration must be done one at a time to setup. 
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It will register one Controller number with its basic data for configuration.  Select Save button 
to complete the process. 

Repeat the procedure to add additional Controllers. 

4) Select Controller Type as Controller Type. 

5) Select Door Type as 1 door. 

6) Input Controller Name.  This is a must in order to define the location, when an event occurs to a 
Controller. 

7) Configure card memory.  Depending on card memory setup, the event memory is automatically 
setup.  Configure adequate amount of card and event memory. 

8) Default Controller value is optional.  It is not necessary for operation. 

9) Select Save button to save data. 

10) Select Close button to finish. 

Dial-Up Connection 

Dial-Up Connection uses standard phone line to connect to a remote device for communication.  
External modems are required for each site at remote and host to connect by phone line. 

Also, Dial-Up Connection Management can be used to manage multiple location registration, and 
when needed initiate the location’s remote device and communication. 

 Start 

Select Set Up->System Management->Dial-Up Connection List or press shortcut key Ctrl+G. 

 Find 

Find is used to get relevant information pertaining to the inquiry when information is available.  It is 
used to edit and delete the existing data information. 
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1) Input Find Condition 

2) Select Find to make an inquiry.  If inquired result is available, the following screen appears. 

If find has no specific parameters, it will display the entire information 

 Add 

Add is used to create new data.  Select Add button to add Dial-Up Connection area data through 
input screen. 

  

1) Select Add button, and the following screen appear 
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2) Select Loop No.  You can only select the port that was configured for Dial-Up Connection. 

3) Input Dial-Up Chain Name. 

4) Check mark Out Line if setup, and input Out Line No. 

5) Input Remote Phone No. connected to remote modem. 

6) Check mark Auto Dial-Up Connection if setup, and configure connection and disconnection time. 

When configuring Auto Dial-Up Connection, make certain that connection and disconnection 
time does not overlap in multiple location setups.  This will cause abnormal operation. 

7) Select Save button to save input data.  Select Close button to finish. 

In Dial-Up Connection, connection failure can be frequent depending on phone line and 
modem status.  This is a special characteristic occurrence, and if 2-3 reattempts are made 
normal connection is established. 

 Dial 

Dial can be used in Dial-Up Connection List, Add, and Modify screen, but we recommend use as 
possible in the Dial-Up Connection List screen. 
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1) Use Find to locate connection or select from Dial categories to connect.  Selected location is 
highlighted. 

2) Select Dial for connection attempt.  

 

 Hang Up 

 

1) Select current established connect location. 

2) Select Hang Up to disconnect. 
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Chapter 

9 Maintenance & Management 

DUAL PRO™ Program Maintenance and 
Management 
 
This chapter explains instructions for optimized program use through 
proper management and maintenance. 

DUAL PRO™ program’s Database Maintenance and Management 

In using the DUAL PRO™ program, it requires some management, especially ongoing database 
management.  As the database becomes larger, it needs thorough managing by the user.  Even if the 
data is few, database management is a requirement. 
 
The program running speed may become slower, as the database becomes larger, and abnormal 
closing of program may damage the database.  The user should maintain ongoing database 
compression, backup, or copy the files to optimize program use. 

 
Database Management 

Database Management describes the compression, backup, and restore function of data in using the 
DUAL PRO™ program. 

 Start 

Select Database->Database Management. 

 Cardholder Data Backup 

In case of losing data of Cardholder it is recommended to backup Cardholder data. 

And the usage is same with Data Backup. 

 Data Backup 

The advantage of this function is blocking the damage to the database, and improving the 

program performance through Data Backup.  After backup is completed, compress the database 

to improve the database speed. 
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1) Select the Event Data, Alarm Data, or Visitor Event Data for Backup Option.    

Safekeeping event data is a must, because it is used later on in reports and as original data 
for time attendance function.  Keeping the original data lets the user restore data in the event 
of data abnormality in time attendance and access control results. 

You can use Microsoft Access 2000 or XP to manage the access user and device data in 
addition to the above. 

2) Select the From/To of Backup Period Condition to define backup files. 

3) After database backup, check delete if deleting original data, and check compress if compressing 
original data. 

4) Select Backup button. 
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5) Inputs file name and folder location to save in. 

6) Select Save button. 

 Cardholder Data Restore 

After backup of Cardholder Data is done you need to restore backup data 

The usage is same with Data Restore. 

 Data Restore 

It is used to restore the backup data.  If original data was deleted during backup, specific period 
data is not found.  In this case, use restore function to restore the backup data into the existing 
database file. 

If restoring the same file twice occurs, it makes a duplication data.  Do not restore a file that was 
already restored. 
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1) Select the data to be restored. 

2) Select File Open button. 

 
 
3) Locate the backup file folder and select Open button. 
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4) Select Restore button. 

 

 
 
 

5) Restore status is shown on the progress bar. 

 
 
 Backup Option 

Backup Option configures backup alert presence.  Each event type backup alert cycle can be 
configured in week units.  This alert cycle is based on last backup date.  When the user configured 
week is past, backup message is displayed. 
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1) To use Backup Alarm, check Backup Alarm Use/Unuse. 

2) Configure Event Data for Backup Alarm in week units. 

3) Configure Alarm Data for Backup Alarm in week units. 

4) Configure Visitor Event Data for Backup Alarm in week units. 

5) Select Apply button to save. 

When the configured reminder to backup occurs, it will display the following screen message. 

 
 
 

 Database Management History 

This function manages history of backup and restores activities.  Through this management, you 
will know when, who, and what did something to the database. 
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While using the existing DUAL PRO™ program, if reinstallation is needed, it is 
recommended to have a copy of the existing complete database. 

Backup and Restore function is limited to the event data.  Therefore, it is 
recommended to have copy of complete database in a separate folder, if program is 
installed another PC or deleting the existing system and reinstallation is performed. 

Using Access Program to Manage Database  

The DUAL PRO™ uses Access database contained in Microsoft Office 97.  If Access program is 
installed in a PC with DUAL PRO™ program installed and operating, it can manage the database files 
directly by opening it.   

 Database Compress and Restore 

This function initiates Compress and Restore of database where it may be damaged, and 
database with frequent add and delete history.  In Restore, database file that may have been 
damaged due to abnormal closing of program in general can use this function, but if the damage 
is severe, restore may not be possible. 

This function is recommended in weekly basis, if frequent add and delete is done to the database.  
It does not matter how many times this function is performed, so set the cycle at intervals of 1 
week, 1 month, and 3 month to initiate. 

  
1) Compress and Restore database file is opened using Access program. 

2) Select Tools->Database Utilities->Compact and Repair Database to initiate compress and restore 
function as shown below. 
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When using the function of Compact and Restore, you need to make certain the DUAL 
PRO™ program is not running.   

If compacting database files in a server, or shared folder containing multiple user files, you 
need to make certain if anyone is opening the file that was selected for compact.  To compact 
Access database, sole authority is needed to open/initiate correspond database. 

 

 

 

 

 

 

 

 

 

 

 

 

] 
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Chapter 

10  STARWATCH DUAL PRO I 
Multi Language Setup  

DUAL PRO I™ Program Multi Language Setup 
 
This chapter explains DUAL PRO I™ Program Multi Language Setup 
instruction. 

Using Multi Language Setup Program  

The DUAL PRO™ Multi Language Setup Program is used to configure DUAL PRO™ Program multi 
language support. It is for the user to configure the language preference, form, menu, drop down list, 
and message functions to input and modify data. 

 

Screen Layout 

Initiating the DUAL PRO™ Multi Language Setup Program will display the following screen. Main 
window consist of left hand side menu and right hand side function types.  
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Menu Layout 

Multi Language Setup Program menu and its function types are the following. 

 Set Language 

Configure language preference by character style. 

 Set Menu 

Configure language preference for the top part menu display. 

 Set Form 

Configure language preference for characters in input/output on screen display. 

 Set Message 

Configure language preference for characters in message display. 

 Set DropDown List 

Configure language preference for characters in all Drop Down Combo display. 

 Set Etc 

Configure language preference for the remaining categories. 

 Exit 

Save configuration. 

Menu 
Function setting 
menu of multilingual 
setting program of 
DUAL PRO™   

Program Area 
The screen of function selected in 
menu is shown in program practice 
area. The functions users want is 
executed through this area. 
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Set Language 

Language configuration is the setup of fonts for each language type. 
 

 Start 

Select Set Language from left hand side menu. 
 

 Setup 

1) Select language used in language category. 

 

2) Select Screen Font 

  
 

3) Select Save button to save data. 

Set Menu 

Setup language preference for top part of menu. 
 

 Start 

Select Set Menu from left hand side menu. 
 

 Setup 

Multi Language input screen display the following, and the Korean and English languages are 
shown.  Input the user’s language with English as the standard base. 
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For example, if using User Define 1 language, input the language preference by looking at the 
English Row. 

 
 

 The above input will display the following screen.  If all inputs are completed, select  
 Close button to finish.  Inputs are saved automatically without a separate save 
 function.  All user needs to do is input data. 
 

 
 

 

Input the user’s language with 
English as the standard base. 
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As shown above, input the menu caption then select User Language 1 in DUAL PRO™ program, 
and it will display the following screen below. 
 

 
 

 
 

  
 
 
 
 
 
 

Set Form 

Setup of characters displayed in all input/output screen display. 
 

 Start 

Select Set Form from left hand side menu. 
 

 Setup 

Multi Language input screen display the following, and the Korean and English language can be 
seen.  Input the user’s language with English as the standard base.  

For example, if using User Define 1 language, input the language preference by looking at the 
English Row. 
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As shown above, input the form caption then select User Language 1  
in DUAL PRO™ program and it will display the following screen below. 
 

 
 
 

 
Set Message 

Setup of language message display in DUAL PRO™ program. 
 

 Start 

Select Set Message from left hand side menu. 
 

 Setup 

Multi Language input screen display the following, and the Korean and English language can be 
seen.  Input the user’s language with English as the standard base. 

Input the user’s 
language with English 
as the standard base. 
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For example, if using User Define 1 language, input the language preference by looking at the 
English Row. 

  
 
Message box display of Language: 1.Korean setup. 
 

 
 
Message box display of Language: User Language1 setup. 

 

 
 

Set DropDownList 

Configure language preference for input/output in all Drop Down Combo display. 
 

 Start 

Select Set DropDownList from left hand side menu. 
 

 Setup 

Multi Language input screen display the following, and the Korean and English language can be 
seen.  Input the user’s language with English as the standard base. 

Input the user’s language with English as 
the standard base.
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For example, if using User Define 1 language, input the language preference by looking at the 
English Row. 

 

 
 

DropDownList display of Language: 1.Korean setup. 
 

 
 
DropDownList display of Language: User Language1 setup. 
 

 
 

Set Etc 

Setup of language for default value input items. 
 

 Start 

Select Set Etc from left hand side menu. 
 

 Setup 

Initiating the Multi Language input screen will display the following.  Input language preference in 
CAPTION column using REF CAPTION as base.  A separate column for Etc is not available.  
These values cannot be setup due to fixed value setup in database.   

Input the user’s 
language with English 
as the standard base.
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However, using REF CAPTION as base to modify the CAPTION column value, the fixed value of 
data language can be modified.   

REF CAPTION cannot be modified.  This value is for reference to language modification.  The 
actual character displayed in program is the CAPTION column value. 

 
 

 

The modified details in DUAL PRO™ Multi Language Setup Program is applied immediately 
without rebooting the DUAL PRO™ program.   

However, the current running screen needs to be closed and reopened to display the 
modified language. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Input the user’s 
language with REF 
CAPTION as the 
standard base.



 
 
 
 
 
 

STARWATCH DUAL PRO I™ 

283 

Chapter 

11 
STARWATCH DUAL PRO I  
Additional Function 

Functions added to STARWATCH DUAL PRO I 
: Applied only to STARWATCH DUAL PRO I v2.00.00 or over.   

Added functions  

 

System management 
• Fire Group 

- Set controller’s input point on fire signal.  
According to fire signal, Fire Group function sets up emergency (fire) exit.  
When fire signal occurs, set access door will be open. 

 
Card holder management  

• Personal Tracking 
- Personal Tracking function monitors being permanently stationed passer at Access Control 

System. 
• Guard Tour 

- Guard Tour function register/manage patrolman card, patrol area and patrol time. 
And it manages to result according to patrol.  

 
 

A. Detailed description of added functions. 
System Management 

- Fire Group 

 
o Fire Group 

Set controller’s input point on fire signal.  
According to fire signal, Fire Group function sets up emergency (fire) exit.  
When fire signal occurs, set emergency (fire) exit will be open. 
In case of no set Fire Group, occurred fire signal will make open connected all access doors in 
system. 

- Fire Signal Definition 

Should set connected fire signal on controller’s input point to set Fire Group. 
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 Start 

Set Up -> Input/Output Definition -> Set fire signal on connected input point  with fire signal 
selecting controller’s input point Definition. 

 Set up Input Point Definition  

Input/ Output Definition set up mutual operational relation to occur signal for specific output when 
input signal occurs. And Input/Output sets seconds if output signal operates for some time. 
In addition, when input signal occurs, type of input signal and text of indicated customized 
definition can set. 
According to setting door type of input/output controller, relational information about input/output 
signal conception by standard controller default value was created and saved automatically on 
database. 
On this account, user cannot need addition and deletion. In case of changing only some 
information about mutual occurrence relation, operation time, input point of input/output signal, 
user can modify and transfer. 

 Find 

In case of existing set information already, Find is used when you search data in accordance with 
condition using Find condition. Therefore Find is used when you modify existing data. 

 

4)  You select condition in accordance with Port No. and Controller No. 

5)  You search clicking Find button. In case of existing found result, detail is indicated. 

 Modify 

To set by fire signal, you modify Input point which fire signal was inputted. 

And you select controller’s input point to modify. 

Selected data is indicated on selection.  
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9)  You click Modify button. 

 

10)    You select Area(Location), Floor(Location) information. If you select location which  
              input signal occurs, you can confirm which event occurred any location at event  
              occurrence. 

11)  Set input point’s type on ‘Fire’.  

   STARWATCH V2.00.00 recognizes selected input point to fire signal. 

12)  Input point name indicates showed text on event occurrence window when fire  
               signal occurs. 

13)  From 1 to 15 output decides whether output separately operates or doesn’t  
 
               operate when corresponding input signal (fire signal) occurs.  
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               Inputted value on output set time (seconds) that output operates. 

14)  In case of inputting 00s, corresponding output signal doesn’t occur.  
               When you input (select) from 01s to 99s range value, relative output as set   
               second as operates. Access door can be open through controller by itself as well as                   
STARWATCH 

15)  Save clicking a Save button. 

16)  Transmit to controller clicking Transmit button. 

17)  Finish clicking Close button. 

 

- Fire Group Definition 

When fire point occurs, Fire Group Definition appoints access door that will be open. 

 Start 

Set Up -> Select Fire Group Definition.  

 Find 

In case of having set information already, Find is used when you search data in 
accordance with condition inputting find condition. When you modify existing data, Find is used. 

 

 Add 

Add is used when you generate new data. When you supplement Fire Group, you input data 
clicking ‘Add’ button on data input screen. 
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12) Click ‘Add’ button. Then registration screen about Fire Group is showed. 

 

13) Select fire point to register wished Fire Group. If fire point has set, fire point code is automatically 
allocated. 
 

14) If set fire point doesn’t exist, you can’t set Fire Group. Fire point code is order of port number, 
controller number and input point number. 
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15) When you input fire point signal, you select access door wished to open. 

Add to Fire Group clicking ‘>>’ button or cancel clicking‘<<’ button. 

 

16) Save selected access door clicking ‘Save’ button. 

17) When signal occurs on fire point, set Fire Group access door will be open on fire point. 
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Cardholder management 

- Personal Tracking 

- Guard Tour 

o Personal Tracking 
Personal Tracking monitors that access person has been stationed permanently. 

 Start 

Set Up -> Personal Tracking Reader Definition 

 Personal Tracking Reader Definition 

Set IN and OUT Reader List in appointed space for check-in management.  

Can understand that check-in condition about read and entered access person 
through set reader by space’s IN Reader.  
Check-out is processed about read and went out access person through set reader to space’s 
OUT Reader. 

1) Execute on the reader’s registration about check-in management. 
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2) In Available Reader List, select IN Reader of space that has been wished to check-in 
management. 

3) Select IN Reader List clicking ‘>>’ button. 

 

4) In Available Reader List, select Out Reader of space that has been wished check-in 
management. 
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 Personal Tracking Report 

Finds/ Prints personal tracking report during check-in. 

Do leaving process about incorrect data too.  

1) Report -> Personal Tracking Report 

 

2) Click ‘Find’ button after you select Find Condition.  

And then it shows personal tracking report, final area and time during check-in.  
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3) If you want to print about Personal Tracking Report, you must click ‘Print’ button. 

     

4) If incorrect results come out real check-in condition differently, you can manage forcibly leaving 
process. You do leaving process selecting incorrect data and clicking ‘Yes’ button about inquiry 
that “Delete the data you select?”  
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o Guard Tour 
Register/Manage card, area and time of Guard Tour.  

Manage result according to Guard Tour. 

 Start 

Access Control -> Guard Tour 

 Guard Tour Definition 

Set employee, course and time etc. for guard tour. 

1) Access Control -> Guard Tour -> Guard Tour Definition 
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2) Select Guard List tab on Guard Tour List. Click ‘Add’ button to register employee for guard tour. 

3) Select employee for guard tour among registered access persons. Add employee for 
guard tour clicking ‘Add’ button in Guard Tour List. 

 

4)  Close to register employee for Guard Definition clicking ‘Save’ button. 

5) Select Guard Tour List tab on Guard Tour List window. Click ‘Add’ button to register 
course and time for guard tour. 
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6) Select Guard Tour List tab on Guard Tour List window. 

7) Input Guard Tour Code and Guard Tour Name.  

8) If order is appointed, option that ‘Sequenced Guard Tour’ will be selected. 
If you check option that ‘Sequenced Guard Tour’, you can appoint ‘Check Time’.  
And employee for guard tour should progress patrol fitting Check Time. 

8-1) In case of ‘Sequenced Guard Tour’, Set ‘Tour Time’. Set ‘Tolerance for Early Arrival’ and 
‘Tolerance for Late Arrival’.  

For standard ‘Tolerance for Early Arrival’, Guard Tour Employee patrols more 
  early than ‘Tolerance for Early Arrival’. 

For standard ‘Tolerance for Late Arrival’, Guard Tour Employee patrols more 
late than ‘Tolerance for Late Arrival’. 

9) After selecting ‘Selected Check Point’, register Area for Guard Tour clicking ‘->’ button. 
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10) Save data clicking ‘Save’ button. 

 

 Guard Tour Status 

Use at real guard tour. Can start a guard tour and can see a guard tour list. 

1) Access Control -> Guard Tour -> Guard Tour Status 
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2) Select ‘Guard Tour Code’ that you wish to guard tour. 

3) Select ‘Guard Tour Name’. 

4) Start clicking ‘start a guard tour’. Selected person as guard tour employee makes card read in the 
reader which is selected as area for guard tour. 

 

5) If Guard Tour Employee patrols, Touring List and Detail Touring List will show on the screen. 
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6) If you cancel guard tour, you must select ‘Guard Tour’ wished to cancel in Detail 
Touring Cancel ‘Guard Tour’ clicking ‘Cancel’ button. Canceled Detail Touring List was not 
recorded. List.  

7) If guard tour is completed, you must select guard tour that is wished to complete in 
Detail Touring List. Complete guard tour clicking ‘Close’ button. Completed detail touring list can 
be confirmed in Guard Tour Report. 

※ Caution : If registered card for guard tour employee don’t try ‘start a guard tour’, 

it will be used as Employee Card. Only try to ‘start a guard tour’, it is recognized as guard tour. 

 

 Guard Tour Report 

Find about completed guard tour report 

1) Select Report -> Guard Tour Report. 

2) Select ‘Find Condition’. That is Date(From), Date(To), Guard Tour Code and Guard  
Tour Name etc. 

3) Print ‘Guard Touring Report’ clicking ‘Print’ button. 
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